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Nous choisissons les services que nous recommandons de manière indépendante. Lorsque vous cliquez sur un lien partenaire, nous touchons parfois une commission.

Comment faire un business plan ? Modèle gratuit !
Téléchargez notre modèle vierge de business plan et suivez nos conseils pour bien le remplir !

Vous êtes sur le point de lancer votre projet et cherchez comment faire un business plan ? Découvrez ce qu’est un business plan, pourquoi il est important d’en faire un et notre modèle de business plan gratuit à télécharger (modèle vierge). Suivez nos conseils et exemples pour bien le remplir !
Qu’est-ce qu’un business plan ?
Le business plan (plan d’affaires, en français) est un dossier synthétique qui présente un projet de création ou de reprise d’entreprise, en définissant sa stratégie commerciale et financière. Vous pouvez en quelque sorte le considérer comme un CV ou un “book” destiné à structurer et à vendre votre projet.
La création d’un business plan intervient après les recherches documentaires, la prospection, les études et des démarches que vous avez pu mener en amont comme : 
	Le choix d’une forme juridique pour votre entreprise
	La réalisation d’une étude de marché (ou d’un sondage en ligne )
	L’évaluation de vos ressources et de votre business model (modèle économique)

Pour le réaliser, vous aurez plusieurs choix que nous vous présenterons par la suite, mais vous pouvez aussi utiliser notre modèle de business plan gratuit.
Pourquoi faire un business plan ?
Un business plan vous sert d’abord à vous-même : il permet de structurer votre projet de création d’entreprise et de mettre à plat vos idées. Il n’est pas obligatoire. Vous n’êtes donc pas contraint de vous coller à sa conception, assez chronophage.
Dans certains cas de figure, le business plan ne présente pas vraiment d’intérêt. Par exemple, si vous venez de créer votre micro-entreprise et vendez une prestation de  services depuis votre domicile, un business plan se révélera sûrement inutile. À l’inverse, ce document nous paraît incontournable si vous souhaitez créer une boutique en ligne , par exemple ou bien ouvrir un restaurant.
Rappelez-vous : il s’agit aussi d’un outil de communication. Voici quelques exemples concrets pour lesquels on risque fort de vous demander un business plan : 
	lorsque vous désirez ouvrir un compte ou obtenir un prêt bancaire ou un autre financement ;
	lorsque vous recherchez des fournisseurs ;
	lorsque vous comptez vous associer et/ou trouver des partenaires ;
	lorsque vous souhaitez lever des fonds.

Concernant ce dernier point, on peut penser à une start-up qui se lance, souhaite financer son développement et/ou accélérer sa croissance. Faire un business plan doit permettre à l’investisseur de savoir s’il peut s’engager avec elle. Va-t-il y trouver son compte ? Est-ce un projet rentable ? Quels risques prend-il en investissant avec cette startup ?  Un business plan est là pour le séduire et le convaincre. Mais c’est également un outil qui doit inspirer confiance et rassurer sur l’équilibre financier de votre projet, mais aussi et surtout sur les perspectives de bénéfices.
Le business plan a aussi une utilité en interne. Grâce à lui, votre entreprise peut contrôler le pilotage de certaines opérations, tester différentes hypothèses, et réajuster au besoin en le mettant à jour, puisqu’il fournit un cadre de comparaison (ce dont vous manquez cruellement à votre lancement).
Enfin, si vous souhaitez reprendre un commerce ou une entreprise, vous pouvez aussi mettre sur pied un business plan. La trame de base est la même que pour un projet de création d’entreprise, sauf que vous devez aussi intégrer des éléments spécifiques sur l’entreprise que vous allez racheter (ex : historique, clientèle, produits, bilan financier etc.).
Modèle de business plan gratuit et conseils pour le remplir
Les modèles de business plan télécharger.
Vous êtes ici pour ça, donc ne faisons pas durer le suspense. Vous trouverez ci-dessous un modèle de business plan vierge à télécharger gratuitement. Nous l’avons décliné sous plusieurs formats, en fonction de vos besoins :
	Modèle de business plan gratuit word téléchargeable ici
	Modèle de business plan gratuit powerpoint (en cours de création)

Le format Word est idéal pour réaliser un business plan simplifié. Il vous suffira de remplir les différentes parties en suivants nos conseils et en l’adaptant au business d’un food-truck.
Nous vous fournissons uniquement le modèle Word, mais sachez que certains acteurs comme par exemple Créer-mon-business-plan fournissent des modèles beaucoup plus complets pour quelques dizaines d’euros qui vous permettront de recevoir à la fois un modèle Word et un outil Excel pour simuler les projections financières de votre projet de food-truck, ainsi que de l’aide pour le remplir.
Enfin, certains cherchent un modèle de business plan en PDF. Aucun intérêt à notre avis, il sera beaucoup plus facile de le modifier sous Word et d’en télécharger ensuite une version finalisée en PDF.
Exemple de trame du business plan
Le modèle de business plan que nous vous fournissons gratuitement intègre la trame suivante :
C’est un bon exemple de business plan simple et une trame relativement classique, que vous pouvez adapter développer certaines catégories ou au contraire en passer certaines sous silence, selon votre projet.
Nos conseils pour un business plan simple et efficace
Maintenant que vous avez en tête la structure et les éléments incontournables du business plan, il est temps de vous livrer quelques conseils pour concevoir un business plan simple et efficace. Ces conseils valent que vous utilisiez notre modèle ou non.
	Misez sur la clarté et la simplicité. N’en faites pas trop, en particulier si vous présentez un projet avec beaucoup de jargon technique. Mettez-vous toujours à la place de votre lecteur et n’entrez pas trop dans les détails. Adressez-vous à lui avec ses mots.
	Pensez à faire concis et synthétique . Il n’y a pas de règle préétablie sur le sujet, mais on estime qu’un business plan ne devrait pas contenir de 20 à 25 pages. 
	Aérez votre texte en faisant des paragraphes et organisez vos idées avec des parties et des sous-parties regroupées au sein d’un sommaire.
	Ajoutez des visuels lorsque c’est pertinent (ex : diagrammes, graphiques, images)
	Faites-vous relire . Il n’y a rien de pire que de se retrouver à parcourir un document truffé de fautes d’orthographes. Soyez vigilant là-dessus !
	Pensez aussi aux annexes . Elles vous permettent de joindre des documents complémentaires sans alourdir le coeur de votre business plan.
	Etayez votre propos en citant vos sources . Expliquez tous vos calculs et tableaux de chiffres. Justifiez tout ce que vous avancez, en particulier vos projections financières. 

Rappelez-vous, l’objectif du business plan est de convaincre votre interlocuteur, alors produisez un document sérieux et béton, qui ne laisse aucune place au doute. 
4 erreurs à ne pas commettre dans votre business plan
Que vous utilisiez notre modèle de business plan ou non, voici les 4 principales erreurs à éviter lors de la rédaction de votre plan d’affaires :
	Bâcler la forme du business plan
	Mal présenter l’équipe
	Ne pas être exhaustif dans l’étude de marché et de la concurrence
	Négliger le modèle économique et la stratégie commerciale

Comment faire un business plan ?
Les différentes parties.
Chaque business plan est propre à chaque projet. Si sa structure et sa présentation peuvent varier, il doit néanmoins comporter des éléments essentiels que l’on a regroupés en 2 grands domaines (+ 1 bonus) :
	La présentation de votre projet et de votre entreprise : c’est le modèle de business plan que nous vous avons fourni
	Les projections financières : en général un fichier excel

La présentation de votre projet et de votre entreprise 
Dans cette partie du modèle de business plan, vous allez notamment expliquer les modalités opérationnelles de votre business plan en suivant une trame : 
	Le statut de votre entreprise : date de création, forme juridique, nombre d’actionnaires, composition du capital etc.
	Qui vous êtes, les membres de votre équipe et vos associés : parcours, compétences, expérience. Expliquez qui fait quoi au sein de l’entreprise, tout en démontrant que vous disposez de l’ensemble des compétences nécessaires à la réussite de l’activité.
	Une synthèse de votre étude de marché . Elle contient la présentation du produit ou du service que vous souhaitez vendre, votre politique de prix, vos concurrents, le marché que vous souhaitez attaquer, vos avantages concurrentiels etc.
	Une présentation de votre business model .
	Votre stratégie et plan d’action . En premier lieu, on pense à la stratégie commerciale, qui doit présenter vos objectifs en termes de chiffre d’affaires et de croissance. Mais aussi au marketing, à la communication, à la distribution, ou encore à la gestion des ressources humaines.

Tous ces éléments sont bien évidemment inclus dans le business plan gratuit que nous vous avons fourni.
Les projections financières
C’est grâce à toutes ces projections financières que vous allez pouvoir démontrer à vos interlocuteurs la faisabilité et la solidité économique de votre projet. Votre business plan doit notamment contenir les éléments suivants : 
	Le compte de résultat prévisionnel . Il s’agit d’un des éléments-clés de votre plan d’affaires. Ce compte de résultat se présente sous la forme d’un tableau financier. Il doit déterminer le degré de rentabilité de votre entreprise, en démontrant que votre chiffre d’affaires à venir couvrira vos dépenses (charges). Les projections se font souvent sur les trois premières années d’existence de l’entreprise.
	Le seuil de rentabilité : il s’agit du chiffre d’affaires minimum à partir duquel l’activité d’une entreprise devient rentable.
	Le tableau ou plan de trésorerie : établi mensuellement, il présente les encaissements et les décaissements prévus au cours de la première année d’activité de l’entreprise.
	La capacité de financement , c’est-à-dire tous les capitaux et les sources de financement qui permettent de lancer le projet (ex : fonds propres, aides etc.).
	Le plan de financement à trois ans : il détaille vos besoins en financement sur les trois premières années d’activité. Il permet de vérifier que votre entreprise sera pérenne dans le temps.
	Le besoin en fonds de roulement (BFR) . Le BFR correspond aux sommes d’argent dépensées par l’entreprise au lancement de son activité et qu’elle ne pourra récupérer qu’après l’encaissement du paiement de ses premières factures.

Si la partie présentation de l’entreprise est assez facile à remplir, comme vous pouvez le voir dans l’exemple de business plan que nous vous avons fourni gratuitement, la partie financière est plus complexe. Pour cette partie, nous vous recommandons de vous faire accompagner.
Bonus : l’executive summary
L’executive summary – résumé opérationnel, en français – est un teaser d’une à deux pages qui doit donner envie de lire la suite de votre business plan et de découvrir votre projet. Il se place au début d’un plan d’affaires et doit mettre en avant de façon synthétique les informations les plus importantes :
	Votre projet et les problèmes qu’il résout
	Votre stratégie
	Votre offre avec votre avantage concurrentiel
	Votre business model
	Votre marché etc.

Vous disposerez ainsi d’une vision globale de tous les éléments à mettre en avant, ce qui vous facilitera la tâche.
Faire un business plan : quelles sont vos options ?
Plusieurs options s’offrent à vous pour réaliser un business plan : le faire vous-même sans aide tierce, utiliser un logiciel en ligne, ou faire appel aux services d’un professionnel. Chaque solution présente des avantages et des inconvénients.
Option n°1 : faire votre business plan gratuitement (mais vous-même)
Première possibilité pour faire votre business plan : vous y coller seul, sans l’aide d’un logiciel ou d’un professionnel. Pour cela, vous pouvez partir de notre modèle de business plan gratuit et vierge, ou bien d’un modèle de business plan déjà pré-rempli pour certains secteurs. En fonction de vos besoins, utilisez le format Excel, PDF et PowerPoint. 
Créer son business plan en partant de zéro présente d’abord un avantage financier. Vous n’avez aucun frais à prévoir si vous choisissez un modèle de business plan gratuit. Cette solution est idéale pour les entreprises aux budgets serrés, mais elle présente un autre avantage non négligeable : cela vous force à réfléchir en profondeur sur votre projet de création d’entreprise. Par contre, préparez-vous à y passer du temps. La conception d’un business plan est chronophage et peut se révéler fastidieuse, surtout lorsque l’on attaque les prévisions financières.
Notez enfin que certains acteurs (comme Créer-mon-business-plan par exemple), proposent à la fois des modèles de business plan payants à télécharger et la possibilité de le réaliser en ligne. Comptez quelques dizaines d’euros pour un modèle de business plan thématisé (c’est à dire adapté à votre secteur), ce qui à notre avis peut valoir le coup pour éviter de repartir de notre modèle de business plan vierge :
	Choix parmi des dizaines de modèles de business plan
	Business plan au format Word de 10 à 20 pages
	Exemples de textes fournis tout à long du modèle
	Volet financier au formt Excel.

C’est donc un bon compromis entre le business plan gratuit et l’accompagnement (en ligne ou par un professionnel).
Option n°2 : faire son business plan en ligne
La deuxième option consiste à se faire accompagner un peu plus en réalisant son business plan en ligne , à l’aide d’un logiciel dédié. De nombreux sites sont en concurrence sur le marché.
Voici les avantages à utiliser un outil en ligne : 
	Vous disposez de modèles de business plans payants prêts à l’emploi, adaptés à différents corps de métiers.
	Tous les modèles sont centralisés sur la même interface : vous gagnez du temps dans le processus de création. On vous aide à mettre en forme le document, à créer le prévisionnel financier etc.
	Pas besoin d’avoir de connaissances en comptabilité.
	Vous pouvez bénéficier de ressources complémentaires pour concevoir votre plan d’affaires, comme un accompagnement en ligne avec un conseiller.
	Certains logiciels de business plan sont gratuits.

En ce qui concerne les inconvénients, ces modèles de business plan ne sont pas gratuits (mais ils sont complets). Ensuite, en fonction du logiciel que vous choisirez, vous n’aurez pas le droit à du conseil et vous ne pourrez pas déléguer la partie rédactionnelle. Il faudra quand même consacrer du temps pour l’écriture et avoir un minimum de bases pour élaborer votre business plan. Ceci-dit, ces logiciels fournissent de nombreux conseils et des exemples de business plan pour vous aider à remplir le vôtre de manière efficace.
Option n°3 : passer par un professionnel
Si vous cherchez de l’aide pour faire votre plan d’affaires personnalisé sans utiliser un modèle de business plan, rien ne vous empêche de vous attacher les services d’un professionnel. On pense notamment aux professionnels suivants :
	L’expert-comptable local
	L’expert-comptable en ligne
	Les experts et consultants en business plan (ex : les spécialistes de la fiscalité, les avocats d’affaire).

Grâce à un professionnel du business plan, vous vous assurez de gagner du temps et disposez des conseils et du savoir-faire d’un expert. On le recommande en particulier aux projets complexes qui font appel à de nombreuses donnés financières.
Par contre, ce genre de service implique un coût financier plus important qu’avec un logiciel en ligne. Sans compter que vous risquez quand même de devoir collaborer à la partie descriptive du document. Un expert saura parfaitement jouer avec les chiffres, mais il aura besoin de vous pour comprendre la genèse de votre projet ainsi que tous les tenants et aboutissants.
Au cours de vos recherches, pensez aussi à vous rapprocher des structures d’accompagnement de créateurs, de certaines legaltech , des Chambres de commerce et d’industrie ( CCI ), ou encore des Chambres de métiers et de l’artisanat ( CMA ).  Ces différents organismes professionnels proposent souvent des formations et ateliers autour du business plan et pourront vous accompagner dans la construction de votre plan d’affaires.
Au final, quelle que soit la méthode choisie, gardez bien cela en tête : comme le dit l’expression, “on n’a qu’une seule chance de faire bonne impression.” Alors appliquez-vous, et utilisez nos conseils pour réaliser un business plan solide !
Combien coûte un business plan ?
Le coût d’une business plan dépend de l’option que vous allez choisir. Si vous vous utilisez notre business plan gratuit, vous n’y passerez que du temps. Si vous choisissez un modèle payant, vous en aurez pour entre 50 et 100€ environ. Si vous optez pour un logiciel de business plan en ligne , les prix varient d’une solution à l’autre.
La solution la moins économique consiste à passer par un professionnel. Les tarifs dépendent de la complexité et de la technicité du projet. Pour vous donner un ordre d’idées, on a recensé des tarifs partant de 300€ et pouvant aller jusqu’à 4 000€.
Un business plan gratuit, c’est possible ?
Faire un business plan gratuitement, oui, c’est possible en utilisant un modèle de business plan et en y passant du temps, ou bien via certains organismes comme la CCI.
Les personnes ayant téléchargé le modèle de Business plan ont également été intéressés par :
Compte pro en ligne
Compte bancaire et financement en agence
Facturez vos clients
Encaissez et dépensez
Gérez et déclarez
Protégez votre activité
Business plan
Étude de marché
Dépôt de capital social
Création de société
Communauté & newsletter
Événements & Cafés de la création
Guides à télécharger
Dans ma région
Idée business
Devenir entrepreneur
Créer son entreprise
Gérer son entreprise
Développer mon entreprise
Voir tous les articles de blog
Faire un business plan
Business plan PDF
Bilan prévisionnel
Comprendre la TVA
Vie d'entrepreneur
Nos modèles de business plan en PDF

Votre business plan PDF en quelques clics
Répondez à nos questions pour compléter le modèle
On s'occupe des calculs compliqués
Téléchargez votre business plan au format PDF

Réalisez votre business plan en PDF sur mesure
Si vous n'avez pas l'habitude de rédiger des business plans, ce modèle de business plan est la solution idéale pour vous guider dans cet exercice périlleux.
Personnalisez votre business plan, visualisez à tout moment le rendu final et téléchargez-le au format PDF en un clic.
Plus de 150 études de marché déjà rédigés
Une synthèse de votre projet
Un plan de trésorerie sur 3 ans
Le prévisionnel financier qui se calcule automatiquement
La stratégie commerciale et vos objectifs
Vous allez être guidé dans la rédaction de ce business plan pas à pas afin de fournir un business plan convainquant pour votre banquier et pour mieux vous projeter sur votre futur business.
Trouvez votre modèle de business plan en PDF
Modèles de business plan pré-rédigés en pdf, quel format choisir pour un business plan , quelle est la meilleure manière de présenter à quelqu'un son business plan , quels sont les avantages d'utiliser un modèle de business plan pdf  👍, quels sont les inconvénients d'utiliser un modèle de business plan  👎, comment puis-je réaliser mon business plan au format pdf , quelle structure doit contenir un business plan en pdf , que comprend le modèle de business plan pdf proposé .
Créez votre business plan gratuitement
Si vous n'avez jamais rédigé de business plan , il peut être déroutant de se lancer dans le bain sans avoir consulté un exemple de business plan . La lecture d'un modèle de business plan en format PDF vous permettra de comprendre les attentes de votre banquier ou de vos investisseurs afin de créer le business plan idéal 💪

Sachez que si la rédaction d'un business plan vous fait toujours peur, nous vous conseillons d'utiliser notre outil de business plan gratuit qui vous guidera dans la rédaction de votre business plan avant de le télécharger en PDF.
Découvrez nos modèles de business plan déjà rédigés . Choisissez le modèle correspondant à votre activité et adaptez-le à votre projet.
Modèles de business plan déjà rédigés
Business plan d'agence de communication en PDF
Business plan d'agence immobilière en PDF
Business plan d'agence de voyage en PDF
Business plan d'auto-école en PDF
Business plan de bar en PDF
Business plan de boulangerie en PDF
Business plan de caviste en PDF
Business plan de chambre d’hôtes en PDF
Business plan d'e-commerce en PDF
Business plan d'épicerie en PDF
Business plan de fleuriste en PDF
Business plan de food truck en PDF
Business plan de foot en salle en PDF
Business plan de garage en PDF
Business plan d'hôtel en PDF
Business plan d'institut de beauté en PDF
Business plan de location de voiture en PDF
Business plan de magasin de vêtements en PDF
Business plan de micro-crèche en PDF
Business plan d'opticien en PDF
Business plan de restaurant en PDF
Business plan de restauration rapide en PDF
Business plan de salle de sport en PDF
Business plan de salon de coiffure en PDF
Business plan de VTC en PDF
Votre business plan doit contenir deux grandes parties :
Une partie de rédaction dans laquelle il vous faudra présenter votre projet , votre étude de marché ou encore votre profil.
Une autre partie axée sur les prévisions financières de votre business plan.
Le format idéal est de générer votre business plan en PDF pour regrouper la première partie rédigée sur un traitement de texte et la deuxième partie à l'aide d'un logiciel comme Excel .
✉️ D'autre part, le format PDF est assez léger, vous pourrez l'envoyer très facilement par e-mail.
Le business plan est un exercice long et fastidieux, nous vous déconseillons de le faire par écrit à la main.
Réalisez votre business plan gratuitement
Lorsque vous devez présenter votre business plan pour convaincre un investisseur , votre banquier ou un fournisseur , il est important d' envoyer en amont de la rencontre votre fichier PDF.
Le modèle de business plan PDF que nous vous proposons est assez représentatif, c'est un fichier long, qui peut être fastidieux à la lecture 📚. Laissez donc à votre interlocuteur le temps d'en prendre connaissance afin de vous poser toutes les questions utiles le jour de la rencontre.
Bon à savoir
Notre petit conseil est de préparer un PowerPoint pour présenter votre business plan , ce dernier pourra vous servir de support lors de la rencontre et surtout il permettra de résumer visuellement votre projet.
✅ Utiliser un modèle de business plan va vous permettre de comprendre la structure et les parties que devra comprendre votre business plan.
✅ Il va vous permettre de visualiser concrètement à quoi ressemble un business plan.
On vous l'accorde, c'est un exercice qui peut paraître flou quand on en a jamais vu. 🤔
❌ Un modèle est un standard , il ne sera donc pas adapté à votre projet.
❌ Vous ne pourrez pas modifier votre business plan puisqu'il est au format PDF.
La meilleure option est de rédiger vous-même votre business plan. ✍️ Le modèle de business plan en PDF que nous vous mettons à disposition a été généré grâce à notre application , sur celle-ci vous êtes guidé étape par étape dans la rédaction.
Ainsi, votre business plan sera personnalisé à votre projet mais ressemblera visuellement au modèle de business plan présenté sur cette page. Bien sûr, notre outil permet de personnaliser votre business plan avec vos couleurs et votre logo pour ensuite le télécharger en PDF.
Deux possibilités s'offrent à vous :
Utiliser un logiciel de traitement de texte et un tableur puis exporter votre travail au format PDF.
Utiliser un logiciel spécialement conçu pour la création de business plan.
L' outil de business plan Propulse by CA vous permet de rédiger gratuitement votre business plan , de le modifier autant de fois que nécessaire puis de le télécharger au format PDF quand vous le souhaitez.
Pour la structure, nous vous conseillons de reprendre celle de notre modèle de business plan . Elle vous permettra de cadrer votre rédaction et de ne rien oublier.
Notre exemple de business plan correspond à la création d'un restaurant, il vous faudra donc adapter votre modèle, notamment sur la partie tendance du marché, en fonction des éléments que vous avez en votre possession.
Notre business plan est structuré de la manière suivante :
La description du projet
L'étude de marché
Les partenaires et fournisseurs
Les éléments financiers : apports personnels, besoins financiers..
Une deuxième partie vient apporter plus d'informations et compléter la première partie qui est plus synthétique :
Les compétences du porteur de projet
Le contexte et tendances du marché
Les obligations réglementaires du secteur d'activité
Le plan financier détaillé : les projections financières, le bilan financier prévisionnel, la trésorerie prévisionnelle et le tableau de financement

Créez un business plan convaincant en quelques clics et réutilisez-le partout. Si vous avez des questions, un coach vous accompagne.

Business plan : les exemples de nos experts pour le réussir

Définition du business plan (+ Exemple pour comprendre)

Analyse PESTEL : Méthode, Modèle et Exemple

Comment faire un business plan gratuit ? (Guide 2024)

Réussir sa matrice SWOT : notre méthode en 5 étapes

Business plan SAS / SASU : en ligne et gratuit

Réussir son business plan pour se lancer en franchise

Business plan auto-entrepreneur : guide et modèle gratuit

Comment faire son business plan en ligne ? | Propulse by CA

Quel modèle de business plan utiliser ?

Comment faire un business plan convaincant ? | Propulse by CA

Business model canvas : le remplir (exemple à télécharger)

Qu'est-ce qu'une part de marché et comment la calculer ?

Association : les 5 étapes clés pour réussir son business plan

Les 4P du marketing mix : guide complet en 2024
Besoin d'un business plan conforme ?
Réussissez votre business plan en quelques clics grâce à notre outil en ligne gratuit.
Modèle de business plan gratuit à télécharger

Vous êtes à la recherche d’un modèle de business plan gratuit à télécharger ? Bonne nouvelle, vous êtes sur la bonne page !
Document détaillant votre projet ainsi que vos objectifs pour les 3 ou 5 ans à venir, le business plan est essentiel pour créer votre entreprise.
Il vous permettra de vérifier que votre projet est viable financièrement, et vous sera indispensable lors de votre recherche de financement.
Que contient le modèle de business plan gratuit ?
Le modèle que nous vous offrons comprend un plan détaillé au format MS Word ainsi qu'une template de présentation au format MS PowerPoint.
À qui s’adresse ce modèle de business plan gratuit ?
Notre modèle de business gratuit a été conçu avant tout pour les entrepreneurs débutants n’ayant jamais rédigé de business plan auparavant.
Avoir accès à un modèle de business plan vous permettra de vous rendre compte du travail à effectuer en un clin d’œil, tout en bénéficiant d’un guide concret et d’un document auquel vous pourrez vous référer à tout moment.
Conseils pour utiliser ce business plan gratuit
Avant toute chose, nous vous recommandons la lecture de notre guide expliquant comment faire un business plan . Cela vous permettra d’obtenir une vision d’ensemble d’un business plan : de sa définition à l'analyse qu'en font les investisseurs.
Une fois ce guide lu, rendez-vous sur notre article détaillant étape par étape la structure d’un business plan . Vous y trouverez des instructions concrètes et précises pour remplir votre modèle de business plan.
Attention, un préalable indispensable avant de vous lancer dans la réalisation de votre business plan est la réalisation de l’étude de marché. Cette étape est cruciale pour vous permettre d’estimer précisément le potentiel commercial du projet.
Nous avons mis en place un guide pour vous aider à la réaliser, n'hésitez donc pas à le consulter ici .
Prenez également  le temps de lire nos 69 erreurs à ne pas faire dans un business plan , et gagnez un temps précieux en évitant les faux pas commis par d’autres entrepreneurs.
Modèle de business plan gratuit : Word ou PowerPoint, quel format utiliser et quand ?
Vous vous demandez quel est le format idéal pour un business plan ? Notre modèle contient à la fois le format Word et le format PowerPoint, car vous pouvez avoir besoin des deux :
	Format Word : c’est le format que vous utiliserez pour envoyer un dossier détaillé à votre banque, ou à un investisseur qui souhaite étudier en détails votre projet.
	Format PowerPoint : il s’agit du format idéal pour présenter une version synthétique de votre business plan à un investisseur lors d’un premier contact (envoie d’un teaser par email) ou rendez-vous (le fameux pitch).

Quelles différences entre ce business plan gratuit et notre logiciel de business plan en ligne ?
Ce modèle de business plan vous permettra d’avoir un aperçu de ce que doit contenir un business plan.
Cependant, si vous n’avez jamais rédigé de business plan auparavant, l’idéal reste d’utiliser un logiciel spécialisé.
Vous pourrez y créer facilement votre prévisionnel financier sans avoir besoin de connaissances en comptabilité, ni devoir réaliser de calculs compliqués : le logiciel se charge de tout !
Vous serez guidé pas à pas à chaque étape de la rédaction, et obtiendrez un document professionnel sans perdre des heures sur la mise en page.
Si cette solution vous intéresse, sachez que vous pouvez essayer gratuitement notre logiciel de business plan : aucune installation n’est nécessaire et notre service après-vente réactif se tiendra à votre disposition si vous avez la moindre question.
Modèles de business plan thématiques
The Business Plan Shop dispose également de nombreux modèles de business plan thématiques à télécharger :
	Modèle de business plan de restaurant
	Modèle de business plan de salle de sport
	Modèle de business plan d'hôtel
	Modèle de business plan de salon de coiffure
	Modèle de business plan de magasin de vêtements
	Modèle de business plan d'entreprise de bâtiment
	Modèle de business plan de pizzeria
	Voir la liste de tous les modèles de business plan

Nous espérons que ce modèle de business plan gratuit vous sera utile. N’hésitez pas à nous contacter si vous avez la moindre question.

Fondateur & CEO at The Business Plan Shop Ltd
Guillaume Le Brouster est un entrepreneur et un financier chevronné.
Guillaume est entrepreneur depuis plus de dix ans et possède une expérience directe en création, gestion et développement d'une entreprise prospère.
Avant d'être dirigeant d'entreprise, Guillaume a travaillé en banque d'affaires et en capital-investissement, où il a passé la plupart de son temps à créer des prévisions financières complexes, à rédiger des plans d'affaires et à analyser des états financiers pour prendre des décisions en matière de financement et d'investissement.
Guillaume est titulaire d'un Master en Finance de l'ESCP Business School et d'une Maîtrise des Sciences en Gestion de l'Université de Paris Dauphine.
Vous voulez écrire facilement votre business plan ?
Essayez gratuitement notre logiciel de business plan .

Vérifiez que votre projet peut-être rentable et obtenez un business plan professionnel pour votre recherche de financement
Ne partez pas d'une page blanche !
La version complète de The Business Plan Shop donne accès à plus de 50 modèles de business plan.

Besoin d'un business plan professionnel ? Découvrez notre solution
Créez facilement votre business plan !

Réaliser un business plan convaincant est facile avec The Business Plan Shop
Pas prêt à essayer notre outil en ligne ? Obtenez plus d'informations
Business plan simple format Word, PDF

Télécharger le modèle gratuitement
Disponible sous Word & PDF
Votre téléchargement est prêt !
Cliquer pour télécharger le modèle au format de votre choix.
Téléchargez ce modèle sous Word & PDF ou recevez-le par e-mail.
Téléchargez ce modèle sous Word & PDF.
	Envoyer par e-mail

Vous avez aussi débloqué l'accès à notre collection entière de 48 modèles de documents professionnels !
Points clés du modèle
	Le modèle comprend 10 sections : une description de votre entreprise et de l'opportunité qui s'offre à elle, une analyse de son secteur d'activité, une étude de votre marché cible, une présentation de votre équipe de management et de votre stratégie marketing, votre calendrier de mise en œuvre, votre plan de financement et une conclusion. Une partie Annexes est également prévue pour vous permettre d'étayer certains éléments avancés dans le corps du document.
	Des instructions détaillées vous sont fournies pour chaque section.
	Ce modèle vous appartient : ajoutez de nouvelles sections ou supprimez celles qui vous sont inutiles s'il y a lieu.
	Personnalisez ce business plan en ajoutant votre logo et votre branding.
	Téléchargez-le au format Word ou PDF.
	Imprimez-le, envoyez-le par e-mail : faites comme vous voulez.

Aperçu du modèle
Business plan simple.
Business plan
Commencez par une brève description de votre entreprise afin d’en donner le cadre et le contexte. Expliquez aux lecteurs les raisons qui vous ont incité à vous lancer dans cette aventure.
Décrivez les circonstances dans lesquelles ce choix s’est effectué. Expliquez votre projet dans ses grandes lignes, puis de manière plus détaillée. Indiquez aux lecteurs le produit ou service que vous comptez proposer, comment celui-ci s'intègre dans le secteur sur lequel vous allez intervenir, qui sont vos clients cibles et ce que vous attendez du marché à l'avenir. Expliquez votre proposition de valeur et présentez le marché visé.
Fournissez une description succincte de votre équipe de management pour permettre aux investisseurs potentiels de comprendre les compétences et l’expérience dont peut se prévaloir votre entreprise. Présentez ensuite la manière dont vos activités se dérouleront au quotidien.
Puis, décrivez comment vous comptez promouvoir votre nouveau produit/service. Il n’est pas utile ici d’entrer dans le détail, mais veillez cependant à donner suffisamment d’informations illustrant les méthodes de marketing que vous allez utiliser et la façon dont vous prévoyez d’attirer de nouveaux clients.
Décrivez la structure budgétaire et les aspects financiers de votre entreprise. Vous devez expliquer la nature et le volume des investissements dont vous avez besoin, ce à quoi servira l’argent et comment vous envisagez que votre entreprise devienne rentable.
Présentez ensuite la manière dont vous allez mettre en œuvre votre business plan. Comment allez-vous lancer votre nouvelle activité ? Quelle est la chronologie prévue ?
Terminez cette section par une explication claire et concise de votre projet, des raisons qui en justifient la création et des avantages qu'il apportera aux futurs clients et investisseurs.
Conseil HubSpot : Rédigez cette section en dernier lieu, après en avoir fini avec toutes les autres sections. Elle doit résumer l’ensemble de votre business plan en une page ou deux (tout au plus).
Description de l’entreprise
Fournissez une description de votre entreprise. Indiquez le nom de l’entreprise, le type d’entité, qui en est le propriétaire et précisez tous les actifs d’importance.
C’est le moment d’expliquer le pourquoi de votre activité. Quelle est la mission de votre entreprise ? Quels sont vos buts et vos objectifs ?
Quel produit ou service fournissez-vous ? Qui sont vos clients ? Ciblez-vous une zone géographique en particulier ? Le cas échéant, laquelle ?
Décrivez brièvement le secteur d’activité, les opportunités qu’il propose et la croissance qu’il enregistre.
Notez quelques-uns des principaux atouts de votre entreprise et expliquez succinctement son positionnement sur ce marché. Vous y reviendrez plus en détail ultérieurement.
Conseil HubSpot : Cette section doit rester concise. Vous aurez tout le loisir d’évoquer plus en détail votre entreprise et les opportunités commerciales plus loin dans ce document.
L’opportunité
Décrivez le besoin du marché auquel répondra votre projet d'entreprise. Comment ce besoin s’est-il fait jour et pourquoi n'a-t-il pas encore été comblé ?
Expliquez comment vous avez identifié ce besoin et la manière dont votre produit/service y répondra.
Décrivez ici votre produit/service. Vous pouvez insérer des diagrammes ou des images pour illustrer votre offre.
Vous pouvez également inclure une description des caractéristiques et des avantages que votre produit/service apporte à vos clients. Ces informations peuvent être synthétisées dans un tableau simple comme celui ci-après.
Caractéristiques du produit/service
Avantages pour les clients
Conseil HubSpot : Veillez à inclure votre proposition de valeur dans cette section : décrivez en quoi votre service/produit est attrayant pour les clients.
Analyse du secteur d’activité
Utilisez cette section pour parler des tendances environnementales clés qui caractérisent votre secteur d'activité. Quels sont les obstacles à l'entrée (par exemple, les coûts élevés de production ou de commercialisation, les barrières tarifaires, les défis réglementaires, la formation intensive) ? Comment évolue ce secteur d’activité ? Qu’est-ce qui change ?
Pensez ensuite à l'avantage concurrentiel de votre entreprise. Existe-t-il d'autres entreprises qui fournissent le même produit/service que celui que vous proposerez ? Le cas échéant, les clients sont-ils susceptibles de se tourner plutôt vers votre produit/service ? Comment vous positionnez-vous par rapport à vos concurrents ?
Conseil HubSpot : Indiquez les facteurs clés de réussite dans ce secteur et montrez que votre entreprise les possède.
Étude et définition du marché cible
Sur la base de l'étude de marché que vous avez réalisée, expliquez le marché sur lequel votre entreprise va s’implanter. Quelle est son envergure ? Quel est son rythme de croissance ? Votre produit/service représentera-t-il un facteur important sur ce marché ?
Définissez votre clientèle cible. Qui sont les personnes dont vous pensez qu’elles achèteront votre produit/service ?
Vous devez également identifier et décrire dans cette section vos principaux concurrents.
Identifiez ce qui caractérise votre produit/service sur le marché. Quelles compétences ou offres distinctives proposez-vous que d'autres entreprises n'offrent pas ?
Conseil HubSpot : Bien que vous puissiez mentionner certains concurrents, veillez à mettre l'accent sur votre entreprise et sur la manière dont elle servira vos clients cibles.
Équipe de management et organisation
Vos lecteurs voudront savoir que votre équipe possède les compétences et les qualifications requises pour mettre en œuvre ce que vous avez exposé dans le business plan. Fournissez de brèves fiches biographiques des dirigeants, y compris des membres du conseil d'administration (si vous en avez un) et de tout conseiller externe de haut niveau auquel votre entreprise a recours.
Intégrez leurs diplômes et une description des emplois pertinents qu'ils ont occupés et des réalisations qu'ils ont accomplies. Vous pouvez également personnaliser cette section avec des photos de votre équipe pour aider à mettre des visages sur les noms.
Si la structure de votre équipe de management est compliquée, pensez à inclure un organigramme comme celui présenté ci-après. Personnalisez-le pour y inclure les noms et les fonctions de votre équipe de direction.
Conseil HubSpot : Il n'est pas nécessaire de fournir une description de chaque poste de l'entreprise, uniquement celle des cadres supérieurs.
Plan des opérations
Dans cette section, décrivez comment vous entendez gérer votre entreprise et à quoi ressembleront les opérations quotidiennes. Vous devez traiter a minima les sujets suivants, ainsi que toute autre information pertinente qui pourrait être spécifique à votre secteur d'activité :
● Dotation en personnel : combien d'employés comptera l’entreprise ? Où seront-ils implantés ? De quels types de compétences et de certifications ont-ils besoin ?
● Infrastructure : quel type d'espace physique votre entreprise occupera-t-elle ? Décrivez vos locaux professionnels. De quels types de technologies aurez-vous besoin ?
● Structure juridique : les aspects juridiques sont importants dans tous les secteurs d'activité. Décrivez les aspects spécifiques qui vous sont propres et la manière dont vous allez les aborder.
● Aspects réglementaires : les réglementations jouent également un rôle déterminant dans la plupart des entreprises. Prévoyez un point sur les questions réglementaires qui se posent dans votre secteur et sur la manière dont vous allez les traiter.
● Certifications ou accréditations : votre entreprise a-t-elle besoin de documents spéciaux dans le cadre de ses activités ? Le cas échéant, décrivez comment vous allez obtenir la certification ou l'accréditation requise.
● Processus de fourniture du produit/service : décrivez vos processus d'entreprise. Il peut s'agir de stocks, de la chaîne d'approvisionnement et des comptes créditeurs et fournisseurs.
Conseil HubSpot : Cette liste n'étant pas exhaustive, veillez à inclure suffisamment d'informations pour aider les investisseurs potentiels à comprendre la manière dont votre entreprise fonctionnera.
Stratégie marketing
Le marketing est une composante cruciale du succès de toute entreprise. Fort de ce que vous avez décrit dans la section « Étude et définition du marché cible », définissez les éléments de votre stratégie de commercialisation de votre produit/service.
Décrivez tous les défis, y compris les obstacles à l'entrée sur le marché. Quels problèmes potentiels envisagez-vous ? Comment allez-vous les résoudre ?
Justifiez le choix de l’implantation géographique de votre entreprise. Le choix de ce lieu permet-il de réaliser des économies ? Vous permet-il de vous rapprocher de votre base de clients ?
Quelle est votre stratégie de tarification : expliquez et justifiez clairement en quoi la structure de tarification que vous avez retenue incitera les clients à acheter votre produit/service et aboutira, dans le même temps, à un bénéfice pour votre entreprise et vos investisseurs.
Décrivez votre plan pour promouvoir votre nouvelle entreprise, votre nouveau produit ou votre nouveau service. Utiliserez-vous la presse écrite, la radio, la télévision ou les réseaux sociaux ? Prévoyez-vous d’embaucher un responsable marketing ?
Veillez à indiquer le budget de votre stratégie marketing et l’origine escomptée du financement de cet aspect important de votre entreprise. Vous devrez peut-être recourir à des consultants ou à une agence publicitaire : pensez à tenir compte de ces coûts.
Conseil HubSpot : Prévoyez d'inclure des maquettes de vos logos, de vos emballages voire de vos publicités, pour donner aux investisseurs potentiels un aperçu du matériel marketing de votre entreprise.
Plan et échéancier de mise en œuvre
Décrivez les phases de lancement de votre entreprise. Indiquez la phase dans laquelle vous vous trouvez actuellement et combien de temps prendra la mise sur le marché de votre produit/service.
Pensez à inclure une chronologie comme celle ci-après pour illustrer les étapes du processus. Personnalisez-le en fonction des dates et des étapes spécifiques à votre entreprise.
Conseil HubSpot : Tout en visant à satisfaire les investisseurs potentiels, veillez à fixer des délais raisonnables que vous êtes en mesure de respecter.
Plan de financement
Précisez à vos investisseurs potentiels le montant des fonds que vous avez reçus jusqu'à présent et leur provenance. De quels montants supplémentaires avez-vous besoin ?
Décrivez la façon dont vous allez employer chaque partie du financement que vous demandez. Cela rassure souvent les investisseurs de savoir exactement comment leur argent sera utilisé.
Donnez aux lecteurs une visibilité sur l'avenir financier prévu de votre entreprise. Fournissez les éléments suivants en annexe, mais décrivez-les dans la présente section :
● Projection en matière de trésorerie : il s’agit d’une estimation du volume d'argent que vous prévoyez de faire entrer et sortir de votre entreprise.
● Plan de capitalisation : il établit la liste des sources et des utilisations des capitaux que votre entreprise prévoit d'accumuler.
● Analyse du seuil de rentabilité : détermination de ce que vous devez vendre afin de couvrir les coûts de votre entreprise.
Outre ce qui précède, vous devrez fournir un compte de résultat et un bilan. Comme ces documents peuvent être longs et qu'ils ont probablement été réalisés sous Excel ou un logiciel de comptabilité, vous devez en faire état ici et les joindre en annexe.
Il est également judicieux d’expliquer toutes les hypothèses que vous avez pu émettre et qui auraient une incidence sur vos données financières. Vous pourrez y revenir ultérieurement pour expliquer pourquoi quelque chose a pu se passer autrement que prévu.
Conseil HubSpot : Il s’agit de l'une des parties les plus importantes de votre business plan. Si vous n'êtes pas un expert en finances, faites-vous aider par une personne compétente.
Résumez en quelques phrases le point principal que vous souhaitez faire comprendre aux lecteurs concernant votre entreprise. Tentez de les convaincre qu’ils doivent investir dans votre projet !
Décrivez les étapes à venir et communiquez-leur des coordonnées détaillées afin qu'ils puissent vous contacter facilement.
Conseil HubSpot : Cette section doit inciter les lecteurs à passer à l’action. Facilitez la tâche de vos investisseurs potentiels en précisant dans cette section toutes les informations dont ils ont besoin pour franchir le pas.
Insérez ici toutes les pièces justificatives des sections précédentes. Elles apportent des informations détaillées supplémentaires. Vous pouvez y faire référence dans votre business plan sans introduire de rupture de votre contenu.
Conseil HubSpot : Vous pouvez notamment inclure les éléments suivants : supports marketing, cartes du site d'implantation de l'entreprise, recherches contextuelles, articles publiés sur l'entreprise et documents financiers.
Questions fréquemment posées
Comment rédiger un business plan simplifié , ce modèle est-il gratuit , ce modèle peut-il être modifié , modèles liés:.
	Business plans

Plus de modèles
Attestation de vente.
Créez un registre fidèle de vos transactions commerciales à l'aide de ce modèle d'attestation de ven...
Proposition commerciale
Utilisez ce modèle de proposition commerciale professionnelle pour présenter votre entreprise aux cl...
Want to track your sales activities and customer interactions, but not quite ready for a CRM softwar...
Envoyez rapidement des devis à des clients potentiels.
Note de synthèse
Présentez clairement les avantages, les coûts et les risques de votre projet à l’aide de ce modèle d...
Fiche de poste
Améliorez vos processus de recrutement et d'intégration de talents avec ce modèle de fiche de poste.
Calcul des heures de travail
Avec ce modèle de calcul des heures de travail, vous pouvez comptabiliser avec exactitude les heures...
Rapport d’activité annuel
Ce modèle de rapport d’activité annuel constitue une trame que vous pouvez compléter et enrichir à v...
Executive Summary
Appuyez-vous sur ce modèle d’Executive Summary afin d’élaborer une synthèse efficace et convaincante...
Étude de marché
Ce modèle d’étude de marché vous servira de support pour organiser vos recherches sur un segment de ...
Bilan comptable
Ce modèle de bilan comptable est un document incontournable qui vous accompagne dans la gestion fina...
Compte rendu de réunion
Ce modèle de compte rendu de réunion vous guide dans la prise de notes et la synthèse des rendez-vou...
Accéder à ce modèle gratuitement

Free Download
Business plan template for small businesses, startups, & entrepreneurs
Business planning can feel complicated. it doesn't have to be. start putting pen to paper today with your free business plan template download..
Available formats:

Downloads: 922,750
Our free template includes:

	Detailed instructions

More than just a template, you'll learn how to write a winning business plan.

	SBA-lender approved format

Your plan is formatted the way lenders and investors expect.

	Fill-in-the-blanks simplicity

You don't need to be an expert. This template makes business planning easy.

	Expert tips & tricks

Get expert guidance sent straight to your inbox!

All 100% free. We're here to help you succeed in business, no strings attached.
Start your business plan today
Whether you're writing a business plan to validate your business idea, secure funding, or grow your existing business – our template will help you achieve your goals.

Business plan template FAQ
What is a business plan template?
A business plan template is a document designed to help streamline your ability to write a business plan. It handles the structure and organization so that you can focus on filling in the blanks and defining the key aspects of your business.
Why choose this business plan template?
There are a few key features that make this business template more functional and effective than your average template.
	Written by planning experts:  This business plan template wasn't just thrown together. It was crafted by seasoned planning experts with a combined 40 years of experience writing and reviewing business plans. Throughout this template, you find their expert tips and tricks, along with detailed instructions.
	Free course access: When you download your business plan template, you'll get access to a week-long email course covering critical business planning mistakes to avoid.
	Works with other Bplans resources: Need additional guidance to write your business plan? Our free business planning guide  is built to support this template—giving you even more detailed walkthroughs for each section.
	Designed for funding:  Even if you're not going right to the bank, using this template will prepare you to pursue funding and impress potential investors whenever you're ready. This template ensures your plan is in SBA format.

What is included in this business plan template?
This template includes definitions, guidance, and examples for every business plan component needed to start, fund, and grow your business. After downloading the full template, you'll receive instructions for how to fill out each of the following sections.
Executive summary:  The brief summary of your business plan that introduces everyone to your business, the problem you solve, and what you're asking from your readers. It's the first chapter of your business plan and the last thing you write once you have the details from your full plan.
Problem & solution: More than a simple description of your products and services - here you define the problem you're solving and the value you provide. It's also your chance to showcase any initial traction that shows you're on the right track.
Market analysis and target market: A detailed assessment of the market you intend to enter, including the size and value of the market, potential customer segments, and their buying patterns.
Competition: Show that you know who your competitors are, what advantages you have, and how you're positioning your business to be competitive.
Marketing & sales: Describe how you'll reach and sell to potential customers with a detailed sales plan and chosen marketing channels.
Operations: What makes your business run? Outline the day-to-day workflows, and what still needs to be set up for your business to deliver a product or service.
Milestones & metrics: Set goals for your business that include the dates and people responsible to accomplish them. This is what you'll use to manage responsibilities, track growth, and execute your larger strategy.
Company overview and team: Provide a brief rundown of the legal and structural components of your company including your history, current team, and gaps you need to fill.
Financial plan: Create well-structured and accurate financial statements to help you pitch to investors, land funding, and achieve long-term success. All without the help of a financial advisor or a degree in accounting.
Appendix: While not required, this last section of your business plan is a great place to drop in additional documents that support and strengthen the rest of your plan.
What file formats are available for this business plan template?
You can download and use this business plan template as a Google Doc, .docx (Microsoft Word), or PDF.
Can you print out this template?
This is a printable business plan template that can be downloaded and printed no matter which format you choose.
Why should you start with a business plan template?
Starting with a good business plan template (like this one) includes everything you need to get started. It helps you organize your thoughts, and provides guidance, instructions, and examples to create an investor-ready and SBA-approved business plan format. It really speeds up the planning process. Oh, and it's 100% free!
Why do you need a business plan?
Writing a business plan will help you develop a strategy for success, reduce the risk of starting a business, explore new business ideas, attract investors, and get funding. Learn more about how you can get value out of your business plan .
Is writing a business plan easy?
Using a business plan template can make writing a business plan easier. Additionally, if you focus on just getting your information down quickly, with the expectation that you'll revisit and revise your plan, you can speed up and simplify the process .
What are the 5 elements of a business plan?
While there are more than five sections of a business plan, you can group the key elements of a plan into the executive summary, business opportunity, execution, company overview, and financial plan. Thinking of the plan in this way can help you break up the writing process and make tackling each strategic component a separate and focused task.
Can someone write your business plan for you?
If you're still struggling to write your business plan even when using a template, you can look into hiring a professional business plan writer. We even have a free resource to help you ask just the right questions  to make sure you find the right plan writer.
A faster way to plan.
LivePlan is the #1 planning tool for over 1 million businesses.

Related Resources

Explore 500+ Business Plan Examples

Try the Planning Software Trusted by 1 Million+ Entrepreneurs

Free Step-By-Step Business Planning Guide

Work With a Professional Plan Writer
Download your template now
Need to validate your idea, secure funding, or grow your business this template is for you..
We care about your privacy. See our privacy policy .
Your business plan template is ready
Find a download link in your email too.
Edit in Google Docs
Download as Docx
Download as PDF

Finish your business plan faster
Get an exclusive 7 day free trial to the world's #1 business planning software.

From template to plan in 30 minutes
	Step-by-step guidance
	Crystal clear financials
	Expert advice at your fingertips
	Funding & lender ready formats
	PLUS all the tools to manage & grow


Discover the world’s #1 plan building software
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Business plan gratuit (2024) : exemple et modèle à télécharger (Excel+PDF)

Vous créez votre entreprise et vous souhaitez rédiger un business plan , vous trouverez un modèle de business plan au format word et pdf à télécharger gratuitement et de nombreux exemples

Besoin d’aide pour faire votre business plan ou votre prévisionnel ?
Faites appel à un expert pour vous accompagner dans la réalisation de votre projet.
Business plan PRO  ,  Délais rapides  ,  Tarifs attractifs
Business plan gratuit : Définition et Objectif
Un business plan est un document stratégique essentiel pour toute entreprise, qu’elle soit en phase de démarrage ou bien établie. Ce plan sert de feuille de route, détaillant la vision, les objectifs, et les stratégies d’une entreprise pour atteindre le succès. C’est un outil de communication crucial qui permet aux entrepreneurs de présenter leurs idées de manière structurée et convaincante, notamment aux investisseurs, partenaires, et autres parties prenantes.
Objectifs Clés d’un Business Plan :
	Clarifier la Vision et la Stratégie : Le business plan permet de définir clairement la vision de l’entreprise et la manière dont elle envisage d’atteindre ses objectifs. Cela inclut la mise en place d’une stratégie cohérente, l’identification des marchés cibles, et la planification des ressources nécessaires.
	Attirer les Investissements : Pour les startups et les entreprises cherchant à se développer, le business plan est souvent le premier point de contact avec des investisseurs potentiels. Un plan bien rédigé et convaincant peut faire la différence entre obtenir le financement nécessaire ou non.
	Gestion et Planification : Le business plan sert également de guide pour la gestion quotidienne de l’entreprise. Il aide à anticiper les défis, planifier les ressources, et suivre les progrès par rapport aux objectifs fixés.
	Communication Interne et Externe : En interne, il assure que tous les membres de l’équipe comprennent la direction et les objectifs de l’entreprise. Externement, il communique la mission et les stratégies de l’entreprise aux partenaires, fournisseurs, et clients.

En résumé, le business plan n’est pas seulement un document requis pour attirer des investissements, mais c’est un outil vital pour la planification et la gestion stratégique d’une entreprise. Il doit être considéré comme un document vivant, sujet à des révisions et des mises à jour au fur et à mesure que l’entreprise se développe et que le marché évolue.
Étapes pour Rédiger un Business Plan
Rédiger un business plan peut sembler une tâche ardue, mais en le décomposant en étapes gérables, ce processus devient beaucoup plus abordable. Voici les étapes clés pour créer un business plan efficace :
Comprendre l’Objectif de Votre Plan :
Avant de commencer, définissez clairement l’objectif de votre business plan. S’agit-il de séduire des investisseurs, de guider votre équipe, ou de structurer votre stratégie de croissance ? Votre objectif guidera le ton et le contenu de votre plan.
Recherche et Analyse :
Commencez par une recherche approfondie. Comprenez votre marché, vos concurrents, votre public cible, et vos propres forces et faiblesses. Cette étape est cruciale pour fonder votre plan sur des données réelles et non sur des suppositions.
Rédaction du Résumé Exécutif :
Bien que cette section soit placée en tête de votre business plan, il est souvent plus facile de la rédiger en dernier. Le résumé exécutif doit capturer l’essence de votre entreprise : votre mission, votre produit ou service, vos marchés cibles, et vos projections financières.
Description de l’Entreprise :
Présentez votre entreprise en détail. Incluez votre histoire, structure, objectifs, vision, et les produits ou services que vous offrez. Cette section doit donner aux lecteurs une compréhension claire de qui vous êtes et ce que vous faites.
Analyse du Marché :
Détaillez votre compréhension du marché. Qui sont vos clients cibles ? Quelle est la taille de votre marché ? Quelles sont les tendances actuelles ? Cette analyse doit prouver que vous comprenez bien l’environnement dans lequel vous opérez.
Planification de l’Organisation et de la Gestion :
Décrivez la structure organisationnelle de votre entreprise. Qui fait partie de l’équipe de direction ? Quelles sont leurs expériences et compétences ? Comment votre entreprise est-elle structurée ?
Détails sur le Produit ou Service :
Expliquez en détail vos produits ou services. Quels problèmes résolvent-ils ? Comment se distinguent-ils sur le marché ? Quelle est votre stratégie de développement de produit ?
Stratégie de Marketing et de Ventes :
Décrivez comment vous prévoyez d’attirer et de retenir les clients. Incluez vos stratégies de marketing, de vente, et de distribution.
Planification Financière :
Incluez des projections financières détaillées. Présentez vos états financiers, prévisions de revenus, et analyse de rentabilité. Cette section est essentielle, en particulier si vous cherchez des investissements.
Révision et Réajustement :
Une fois votre brouillon terminé, prenez du recul et revoyez l’ensemble du plan. Recherchez les incohérences, les erreurs, ou les omissions. N’hésitez pas à réajuster et à peaufiner votre plan pour qu’il représente au mieux votre vision et vos objectifs d’entreprise.
Comprendre le Public Cible du Business Plan
Un aspect fondamental dans la rédaction d’un business plan est la compréhension de son public cible. Le contenu et le ton du plan doivent être adaptés en fonction de ceux qui vont le lire et l’utiliser. Voici quelques points clés à prendre en compte pour identifier et répondre aux besoins de votre public cible :
Identifier les Lecteurs Potentiels :
Le public cible de votre business plan peut varier : investisseurs, banquiers, partenaires commerciaux, employés, ou même vous-même en tant que chef d’entreprise. Chaque groupe d’intérêt a des attentes et des besoins spécifiques.
Comprendre les Besoins des Investisseurs :
Si le plan est destiné à des investisseurs, il doit clairement démontrer le potentiel de rentabilité de l’entreprise. Les investisseurs cherchent à comprendre comment ils récupéreront leur investissement et réaliseront un profit. Mettez l’accent sur les projections financières, le marché cible, et la stratégie de croissance.
S’adresser aux Institutions Financières :
Les banques et autres institutions financières sont intéressées par la viabilité et la stabilité financière de l’entreprise. Elles se concentreront sur les flux de trésorerie, la solvabilité, et les garanties. Il est important de présenter des prévisions financières réalistes et un plan de remboursement clair.
Engager les Partenaires et les Employés :
Pour les partenaires commerciaux ou les employés, le business plan doit mettre en avant la vision, la mission, et la culture de l’entreprise. Cela aide à construire un sentiment d’appartenance et d’engagement envers les objectifs de l’entreprise.
Auto-Évaluation et Planification Interne :
Lorsque le business plan est utilisé comme un outil de planification interne, il doit être un guide réaliste pour le développement de l’entreprise. Cela implique une analyse honnête des forces, des faiblesses, des opportunités, et des menaces (analyse SWOT).
Adaptation du Ton et du Contenu :
Selon le public, le ton du business plan peut varier de formel à informel, et le contenu peut aller des détails techniques approfondis à une vue d’ensemble stratégique. Il est crucial de trouver l’équilibre approprié pour communiquer efficacement votre message.
Le Rôle du Business Plan dans le Financement et l'Acquisition de Fonds
Le business plan joue un rôle crucial dans le processus de financement et d’acquisition de fonds pour une entreprise. Que vous cherchiez à démarrer une entreprise ou à financer une expansion, un business plan bien conçu est souvent la clé pour ouvrir les portes du financement. Voici comment un business plan efficace facilite l’acquisition de fonds :
Présentation de l’Opportunité d’Investissement :
Le business plan offre une présentation structurée de votre entreprise aux investisseurs potentiels. Il détaille le potentiel de croissance, le marché cible, et la stratégie compétitive, permettant aux investisseurs de comprendre pourquoi et comment ils peuvent s’attendre à un retour sur leur investissement.
Démonstration de la Viabilité Économique :
Un aspect crucial du business plan est la section financière. Elle doit inclure des prévisions de revenus, des états financiers pro forma, et des analyses de rentabilité. Ces informations aident les investisseurs et les prêteurs à évaluer la viabilité économique et la stabilité financière de votre entreprise.
Établissement de la Crédibilité et de la Confiance :
Un business plan bien rédigé établit votre crédibilité en tant qu’entrepreneur. Il montre que vous avez effectué les recherches nécessaires, que vous comprenez votre entreprise et le marché, et que vous avez une vision claire pour l’avenir. Cette crédibilité est essentielle pour gagner la confiance des investisseurs.
Communication de la Stratégie et des Objectifs :
Les investisseurs veulent savoir comment vous prévoyez d’utiliser leurs fonds. Le business plan doit clairement exposer votre stratégie de croissance, vos objectifs à court et à long terme, et la façon dont le financement demandé vous aidera à les atteindre.
Négociation avec les Investisseurs :
Le business plan sert également de point de départ pour les négociations avec les investisseurs. Il fournit une base pour discuter de la valorisation de l’entreprise, des termes de l’investissement, et des attentes en matière de participation et de contrôle.
Répondre aux Critères des Prêteurs :
Pour les prêts bancaires, le business plan doit répondre aux critères spécifiques des prêteurs. Cela inclut la démonstration d’une capacité de remboursement, la présentation de garanties éventuelles, et la preuve de la gestion compétente de l’entreprise.
Business plan gratuit : Résumé opérationnel , executive summary

Les nouveaux entrepreneurs ou gérant d’entreprise utilisent généralement un Business plan pour présenter leur excellente idée commerciale à des parties prenantes potentielles telles que des investisseurs providentiels. Le but du Business plan est d’attirer le financement des investisseurs ou de convaincre les responsables bancaires d’obtenir un prêt bancaire pour leur entreprise. Un Résumé opérationnel est un aperçu du Business plan qui met succinctement en évidence ses éléments les plus essentiels.
Il ne s’agit pas seulement d’un aperçu général ; le Résumé opérationnel peut être la seule partie de votre Business plan que les cadres et les investisseurs potentiels lisent.
Le Résumé opérationnel d’un Business plan est conçu pour capter l’attention du lecteur et expliquer brièvement votre entreprise, le problème que vous résolvez, le public cible et les principales informations financières. Si le Résumé opérationnel manque d’informations spécifiques ou ne capte pas l’attention du lecteur, le reste du Business plan risque de ne pas être lu.”
Si votre Résumé opérationnel doit être engageant et complet, il doit également être rapide et facile à lire. Ces documents comptent en moyenne une à quatre pages – idéalement, moins de deux pages – et doivent représenter moins de 10 % de l’ensemble de votre Business plan
Business plan gratuit : Organisation et management

Cette section de votre business plan, Organisation et management, est celle où vous expliquerez exactement comment vous êtes organisé pour concrétiser vos idées, et où vous présenterez les membres de votre équipe.
Comme toujours, n’oubliez pas votre public. S’il s’agit d’un plan destiné à votre usage interne, vous pouvez être un peu plus général que si vous le présentez à un prêteur ou à un investisseur potentiel. Quel que soit son objectif, vous voudrez diviser la section sur l’organisation et la gestion en deux parties : l’une décrivant le mode de fonctionnement de l’entreprise (sa structure organisationnelle) et l’autre présentant les personnes concernées (sa gestion).
Maintenant que nous comprenons la structure de votre entreprise, nous devons faire connaissance avec les personnes qui vont la diriger. Qui fait quoi, et pourquoi sont-ils à bord ? Cette section est importante même pour un praticien seul ou une entreprise individuelle, car elle vous présentera, vous et vos qualifications, aux lecteurs de votre plan.
Actionnaires
Commencez par le haut en indiquant la structure juridique et la propriété de l’entreprise. Si vous êtes constitué en société, dites-le et précisez si vous êtes une société C ou S. Si vous n’êtes pas encore constitué en société, assurez-vous d’en discuter avec votre avocat et votre conseiller fiscal pour déterminer la voie à suivre. Si vous faites partie d’un partenariat ou si vous êtes propriétaire unique, c’est ici qu’il faut le mentionner.
Indiquez le nom des propriétaires de l’entreprise, le pourcentage de la société que chacun d’eux possède, la forme de société et le type de participation qu’ils auront dans les opérations quotidiennes.
C’est ici que vous indiquerez les noms et les profils de votre équipe de direction, ainsi que leurs responsabilités. En particulier si vous recherchez un financement, veillez à mettre en évidence les antécédents de ces employés clés. Les prêteurs et les investisseurs s’intéresseront vivement à leurs succès antérieurs, en particulier à leur lien avec l’entreprise actuelle.
Indiquez le nom et le poste de chaque personne, ainsi qu’une brève description de ses principales fonctions. Détaillez sa formation, ainsi que toute compétence ou expérience unique, surtout si elle est pertinente pour le poste à pourvoir. Mentionnez les emplois précédents et les récompenses ou reconnaissances liées à l’industrie, ainsi que la participation à des œuvres de bienfaisance ou à d’autres organisations à but non lucratif.
Considérez cette section comme un résumé du CV, qui récapitule les points forts et les réalisations des personnes dont vous avez choisi de vous entourer. Les CV détaillés de vous-même et de votre équipe de direction doivent figurer dans l’annexe du plan, et vous pouvez y faire référence ici. Vous voulez que vos lecteurs aient l’impression que votre équipe de direction vous complète et complète vos propres compétences. Vous voulez également que les lecteurs comprennent pourquoi ces personnes sont si qualifiées pour contribuer à la réussite de votre entreprise.
Cette section précise la rémunération des membres de l’équipe de direction, notamment le salaire, les avantages sociaux et la participation aux bénéfices que vous pourriez offrir. Si certains membres de l’équipe sont sous contrat ou liés par des accords de non concurrence, vous devez également le mentionner ici.
Conseil d’administration
Si votre entreprise a un conseil d’administration, ses membres doivent également être mentionnés dans le business plan. Présentez chaque personne par son nom et le poste qu’elle occupera au sein du conseil. Expliquez comment chacun d’entre eux pourrait participer à l’entreprise (en plus des réunions du conseil d’administration).
Comme vous l’avez fait pour votre équipe de direction, donnez des informations sur les antécédents de chaque membre, notamment sa formation, son expérience, ses compétences particulières, etc. ainsi que sur les contributions qu’il a pu apporter au succès de l’entreprise. Incluez les CV complets des membres de votre conseil d’administration dans l’annexe.
Si vous n’avez pas de conseil d’administration, vous pouvez également inclure des informations sur le conseil consultatif que vous avez mis en place ou sur un groupe d’experts que vous avez réunis pour vous aider. L’un ou l’autre de ces éléments, soit dit en passant, est une chose que votre entreprise pourrait envisager, que vous prépariez ou non la section organisation et gestion de votre Business plan
Business plan gratuit : produits et services

C’est la partie de votre business plan où vous décrirez les produits et services spécifiques que vous allez offrir. Vous expliquerez en détail le concept de votre entreprise, ainsi que tous les aspects des achats, de la fabrication, de l’emballage et de la distribution. Vous aborderez les fournisseurs, les coûts et la manière dont votre offre s’intègre au marché actuel et se positionne par rapport à vos concurrents.
Même si votre produit est technique, ne vous laissez pas entraîner par le jargon compliqué du secteur. Expliquez et décrivez votre offre en termes simples, afin qu’une personne qui n’est pas familière avec votre activité puisse la comprendre et s’y intéresser. Il peut être nécessaire de donner quelques informations de base s’il s’agit d’un domaine ou d’un secteur que les gens ne connaissent pas.
Lorsque vous rédigez la section Produits et services de votre business plan, gardez votre lecteur à l’esprit. Des choses que vous tenez pour acquises ou que vous connaissez parfaitement peuvent ne pas être connues des prêteurs ou investisseurs potentiels. Lorsque vous rédigez, évitez d’être trop technique, de supposer que vos lecteurs ont trop de connaissances et d’utiliser des mots à la mode.
Vous ne devez pas donner l’impression d’être condescendant, mais vous devez vous assurer que tout le monde comprend ce dont vous parlez. Pour savoir si vous avez réussi, demandez à des personnes de confiance qui ne travaillent pas dans votre secteur d’activité de relire cette section pour vous, et demandez-leur d’expliquer votre produit ou service dans leurs propres mots, ainsi que les avantages de leur utilisation.
Voici les points que vous devez rédiger dans la section Produits et services de votre business plan :
La description du produit ou du service
Quel est votre produit et service, et comment fonctionne-t-il ? Comment les clients en bénéficient-ils ? Comment le fabriquez-vous ou comment allez-vous le faire fabriquer ?
Comparaison des produits
Qu’est-ce qui rend ce produit ou service unique ou meilleur que ce qui est déjà disponible sur le marché ? Pourquoi quelqu’un choisirait-il d’acheter votre produit ou de faire affaire avec vous plutôt qu’avec un autre ?
Accréditations/propriété intellectuelle
Avez-vous fait tester ou certifier le produit ? Obtenu l’approbation d’experts du secteur ? Avez-vous déposé une marque, un droit d’auteur ou un brevet sur votre produit ? Ces éléments peuvent ajouter de la substance et de la crédibilité, alors n’oubliez pas de les mentionner.
Cycle de vie
Où en êtes-vous actuellement avec ce produit ou service ? Est-il au stade de l’idée ou avez-vous un prototype ? En avez-vous produit quelques-uns et cherchez-vous à les développer ? Avez-vous déjà commencé à offrir ce service ou en êtes-vous encore au stade de la planification ?
Tarification
Combien allez-vous demander pour les produits ou services que vous proposez ? Comment cela s’inscrit-il par rapport à ce qui est actuellement disponible ?
Business plan gratuit : L’étude du marché

C’est la partie de votre business plan où vous pouvez vraiment briller et montrer cette idée géniale que vous avez. Bien sûr, votre produit ou service est le meilleur ! Maintenant, parlons de la façon dont vous saurez que c’est un succès. Soyez prêt à montrer que vous connaissez votre marché et qu’il est suffisamment important pour que vous puissiez créer une entreprise durable et prospère.
En rédigeant votre analyse de marché, vous démontrerez les connaissances que vous avez acquises sur le secteur, le marché cible auquel vous envisagez de vendre, vos concurrents et la manière dont vous comptez vous démarquer.
Une analyse de marché n’est rien d’autre qu’un examen de l’environnement commercial pertinent et de la place que vous y occupez. Elle doit permettre à un prêteur, un investisseur ou un employé potentiel de ne pas douter qu’il existe un créneau solide pour ce que vous offrez et que vous êtes certainement la personne qui peut le remplir. Il est à la fois quantitatif, en exposant les projections de ventes et autres chiffres pertinents, et qualitatif, en donnant un aperçu réfléchi de la manière dont vous vous situez par rapport à la concurrence. Il doit prendre en compte la taille potentielle du marché, les clients potentiels que vous ciblerez et les difficultés que vous pourriez rencontrer pour réussir. Voyons comment procéder.
Que faut-il inclure dans une analyse de marché pour un business plan ?
Description et perspectives du secteur
Décrivez le secteur avec suffisamment d’éléments de contexte pour que quelqu’un qui ne le connaît pas puisse comprendre à quoi il ressemble, quels sont les défis à relever et quelles sont les perspectives. Parlez de sa taille, de sa croissance et de ses perspectives d’avenir.
Marché cible
Qui avez-vous identifié comme étant votre client idéal ? Incluez des informations démographiques sur le groupe que vous ciblez, notamment l’âge, le sexe et le niveau de revenu. C’est le moment de parler de la taille de votre marché potentiel, du montant qu’il pourrait dépenser et de la manière dont vous allez atteindre les clients potentiels. Par exemple, si les femmes âgées de 18 à 54 ans constituent votre marché cible, vous devez savoir combien d’entre elles sont présentes sur votre marché. Sont-elles 500 ou 500 000 ? Il est impératif de le savoir. De même, si votre produit ou service est destiné à une clientèle haut de gamme, vous devez vous assurer que vous êtes situé dans une zone qui peut le supporter.
Besoin du marché
Quels sont les facteurs qui influencent le besoin de votre produit ou service ? Ce besoin existait-il auparavant ou essayez-vous de le créer ? Pourquoi les clients voudront-ils faire affaire avec vous, voire vous choisir plutôt qu’un autre ? C’est ici que vous pouvez présenter brièvement l’avantage concurrentiel dont vous disposez, mais vous y reviendrez plus en détail dans les sections suivantes. Concentrez-vous sur la manière dont le produit ou le service que vous proposez répond à un besoin du marché.
Croissance du marché
Bien que personne ne puisse prédire l’avenir, il est important de se faire une idée de ce que seront les affaires à l’avenir et de faire des projections de ventes. Le nombre de personnes dans votre marché cible a-t-il augmenté ou diminué au cours des dernières années ? De combien par an ? Pour faire une prévision intelligente, vous devez commencer par les conditions actuelles, puis projeter les changements sur les trois à cinq prochaines années.
Tendances du marché
Vous devez examiner les tendances de la même manière que vous examinez la population et les données démographiques. Y a-t-il une évolution vers des ingrédients plus naturels ou biologiques qui pourrait avoir un impact sur votre activité ? Comment les prix de l’énergie peuvent-ils être pris en compte ? La facilité d’accès à l’internet et à la technologie des smartphones ? Les questions seront différentes pour chaque type d’entreprise, mais il est important de réfléchir aux types de changements qui pourraient affecter votre marché spécifique. Dans cette section, vous pouvez citer des experts issus des recherches que vous avez effectuées – un expert du marché, une société d’études de marché, une association professionnelle ou un journaliste crédible
Business plan gratuit : La stratégie

Dans cette section du business plan, vous allez expliquer comment vous allez commercialiser votre idée et comment vous allez obtenir des contrats. Les ventes et le marketing sont ce qui fera croître votre entreprise et vous aidera à réussir.
Comme toujours, gardez votre public à l’esprit. Si votre business plan est destiné à vos seuls yeux ou à un document interne pour votre personnel, vous n’aurez pas besoin d’être aussi détaillé ou spécifique que si vous le destinez à un prêteur ou à des investisseurs potentiels. Dans ce dernier cas, vous devrez faire preuve d’une stratégie très bien planifiée qui leur donnera confiance dans votre proposition et les incitera à financer votre entreprise.
Les stratégies de vente et de marketing varient selon le secteur d’activité, et votre stratégie sera adaptée à votre entreprise, mais il existe des lignes directrices générales qui s’appliquent à la plupart des entreprises. Comme votre plan de marketing conduira aux ventes, commençons par là.
De nombreux manuels de marketing font référence aux “quatre P” du marketing, ce qui est un moyen facile de se souvenir des éléments d’un plan solide.
Expliquez en détail le(s) produit(s) ou le(s) service(s) que vous proposez, en particulier en quoi ils sont différents ou meilleurs que ce qui existe déjà. Quels avantages apportent-ils à vos clients potentiels ? En quoi votre produit ou service est-il unique ? En quoi est-il préférable de faire affaire avec vous plutôt qu’avec quelqu’un d’autre ? Tous ces éléments constitueront votre message marketing.
Parlez de la manière dont vous allez présenter l’entreprise et du type d’image que vous allez donner, en particulier de la manière dont cela vous aidera à vous rapprocher de vos clients potentiels. Incluez une photo de votre logo et de tout ce qui peut porter votre image, comme des camionnettes, des camions ou des uniformes. Montrez des captures d’écran de votre site Web, des photos de votre magasin, des images de vos emballages et tout ce qui peut véhiculer la marque de votre entreprise.
Une fois que les clients ont franchi le seuil de votre magasin (ou de votre site Web), vous devez leur offrir ce que vous leur avez vendu. Le marketing, ce n’est pas seulement promettre, c’est aussi suivre et livrer ce que vous avez dit que vous feriez.
Il peut être utile de décrire exactement comment se déroule une transaction avec votre entreprise. Parlez également des politiques de retour et du service clientèle. Vous ne pensez peut-être pas immédiatement qu’il s’agit de questions de “marketing”, mais rappelez-vous la dernière fois que vous avez eu des difficultés avec une entreprise et que vous avez dit à cinq amis que vous ne feriez plus jamais affaire avec elle, ou que vous avez vu quelqu’un se plaindre d’une entreprise sur Facebook ou Twitter. Couvrez vos arrières avant de vous retrouver pris de court dans une situation que vous n’aviez pas prévue.
Il est important de parler de l’endroit où vous serez situé et de la manière dont vous ferez parvenir vos produits et services à vos clients. Si vous envisagez une activité en ligne, aurez-vous également un magasin physique ? Quel pourcentage des ventes prévoyez-vous pour chacun d’eux ?
Si votre activité implique la fabrication ou la distribution d’un produit, discutez des exigences en matière d’expédition et d’étiquetage, et de la manière dont vous les respecterez. Quels sont vos conditions et coûts de livraison ? Faites-vous appel à des distributeurs et facturerez-vous séparément les frais d’expédition ou les intégrerez-vous au prix du produit ?
La façon dont vous décidez de fixer le prix de votre produit ou service est déterminante pour les ventes et les bénéfices que vous pouvez réaliser. Une fois de plus, l’analyse de marché que vous avez effectuée vous sera très utile pour fixer un prix compétitif à votre produit tout en réalisant un bénéfice appréciable.
Vous devriez maintenant avoir une bonne idée de ce que seront vos dépenses, et vous savez donc combien vous devez gagner pour atteindre le seuil de rentabilité. Bien sûr, si vous avez des frais de démarrage (et qui n’en a pas ?), vous devrez également en tenir compte, sachant que votre marge bénéficiaire augmentera lorsqu’ils seront remboursés.
Expliquez comment vous êtes arrivé à vos prix, où ils se situent par rapport à ceux de la concurrence, et quel type de volume vous devrez faire pour être rentable.
Vous pouvez avoir la meilleure idée du monde, mais si personne ne la connaît, elle ne se vendra pas. Alors, comment allez-vous atteindre votre public cible et le transformer en clients ? Allez-vous faire de la publicité ? Quel média ? À quelle fréquence ? Et comment allez-vous répartir le budget ?
N’oubliez pas que certaines formes de publicité traditionnelle et numérique sont coûteuses, comme l’achat d’annonces à la radio ou dans la presse écrite, ou la publicité sur Google. Certaines, comme les médias sociaux ou les relations publiques, peuvent être gérées en interne par un membre du personnel (ou externalisées moyennant des frais). D’autres enfin peuvent avoir un coût très variable, comme l’impression de brochures, de dépliants, de catalogues, etc.
Quel volume d’affaires pensez-vous tirer de chaque campagne ? Allez-vous offrir des coupons, des rabais ou d’autres incitations pour inciter les gens à vous essayer ?
Décrivez comment vous saurez si votre stratégie de marketing est efficace ou non, par exemple le nombre de coupons échangés ou l’augmentation du trafic sur le Web ou dans le magasin que vous prévoyez. Vous devrez prévoir le rendement de votre investissement publicitaire pour déterminer le montant que vous devriez dépenser
Business plan gratuit : prévisionnel financier et comptable

Cette section de votre business plan est cruciale si vous présentez celui-ci à des prêteurs ou investisseurs potentiels, mais elle est également importante si vous l’utilisez en interne comme feuille de route pour démarrer et continuer à vous développer. Vous avez peut-être la meilleure idée du monde pour une entreprise – ou bien elle doit être modifiée. Vous ne le saurez pas vraiment tant que vous ne vous serez pas assis et que vous n’aurez pas établi les chiffres de votre section d’informations financières.
Dans le cas d’une entreprise en phase de démarrage, l’énoncé de vos projections de ventes pour l’avenir vous aidera à examiner de près votre modèle d’entreprise et vos coûts, la façon dont vous allouerez vos ressources et à déterminer si votre idée est vraiment viable. Pour les entreprises existantes, considérez cela comme un bilan financier : une façon d’examiner vos chiffres de vente précédents et de vous assurer de votre santé à l’avenir.
Si vous demandez un prêt ou faites une présentation à des investisseurs, cette section est le complément de votre demande de financement. C’est là que vous étayez les chiffres que vous avez rassemblés dans votre plan de vente et de marketing, et que vous démontrez pourquoi vous êtes un bon investissement. Dans cette section, vous prendrez toutes les informations sur le marketing, les ventes et les produits que vous avez accumulées, et vous montrerez comment elles se traduisent en chiffres. Affutez votre crayon et mettez votre tableur à contribution !
Compte de résultat prévisionnel
Le compte de résultat prévisionnel indique combien d’argent vous avez reçu pour votre entreprise, d’où vient cet argent, quelles ont été vos dépenses et votre revenu net, c’est-à-dire le montant que vous avez obtenu après avoir payé toutes les dépenses. Ces états sont généralement préparés tous les trimestres et permettent de voir en un coup d’œil si l’entreprise gagne de l’argent ou si elle subit des pertes.
Bilan prévisionnel
Le bilan prévisionnel indique le type et la valeur de tous les actifs et passifs de votre entreprise, ainsi que les participations (qui possède quoi dans l’entreprise, et combien). L’actif comprend la caisse, les comptes débiteurs, les stocks, l’équipement et les biens que vous possédez. Le passif comprend les comptes créditeurs et la dette à long terme. Le bilan est un instantané de la situation financière de votre entreprise au moment où il est préparé, comparant ce que vous possédez avec ce que vous devez.
Flux de trésorerie prévisionnels
Le tableau des flux de trésorerie indique toutes les entrées et sorties d’argent de l’entreprise, qu’elles résultent directement de vos activités commerciales ou des investissements extérieurs que vous avez réalisés.
La structure de votre entreprise détermine les formulaires fiscaux que vous devez remplir chaque année auprès de l’administration fiscale. Il peut donc s’agir de votre déclaration d’impôts personnelle ou d’une déclaration d’impôts distincte pour l’entreprise.
Si vous cherchez à obtenir un prêt, vous devrez très probablement indiquer la valeur de toute garantie que vous offrez pour assurer les paiements, comme les biens immobiliers, les véhicules, les stocks, les actions et obligations et les équipements
Analyse SWOT dans le Business Plan
L’intégration d’une analyse SWOT (Strengths, Weaknesses, Opportunities, Threats — Forces, Faiblesses, Opportunités, Menaces) dans votre business plan est une étape clé pour évaluer et planifier la stratégie de votre entreprise. Cette analyse fournit un aperçu complet des facteurs internes et externes qui peuvent influencer le succès de l’entreprise. Voici comment effectuer et intégrer efficacement une analyse SWOT dans votre business plan :
Identification des Forces (Strengths) :
Commencez par identifier les atouts internes de votre entreprise. Cela peut inclure des compétences spécifiques, des ressources, des technologies, des avantages concurrentiels, ou une solide base de clientèle. Les forces sont les éléments qui donnent à votre entreprise un avantage sur les concurrents.
Reconnaissance des Faiblesses (Weaknesses) :
Les faiblesses sont les aspects internes qui pourraient freiner votre entreprise. Cela peut être un manque de ressources, des compétences insuffisantes, des limitations financières, ou des processus inefficaces. Identifier ces faiblesses est crucial pour les aborder et les améliorer.
Exploration des Opportunités (Opportunities) :
Cette partie se concentre sur les facteurs externes qui peuvent être exploités pour le bénéfice de l’entreprise. Les opportunités peuvent provenir de tendances de marché, de changements réglementaires, de nouveaux segments de marché, ou de technologies émergentes.
Analyse des Menaces (Threats) :
Les menaces incluent tout facteur externe qui pourrait nuire à l’entreprise, comme les changements dans l’environnement économique, l’augmentation de la concurrence, les changements dans la réglementation, ou les risques liés à la chaîne d’approvisionnement. Reconnaître ces menaces permet de développer des stratégies pour les atténuer.
Intégration dans le Business Plan :
Une fois l’analyse SWOT complétée, intégrez-la dans votre business plan. Utilisez-la pour informer et justifier vos stratégies de marché, vos plans de développement de produits, et vos approches de gestion des risques.
Utilisation pour la Planification Stratégique :
L’analyse SWOT doit être un outil vivant pour la prise de décision stratégique. Utilisez-la pour réévaluer régulièrement votre position sur le marché et ajuster votre stratégie en conséquence.

Le Business Model Canvas comme Alternative ou Complément
Le Business Model Canvas est un outil stratégique qui offre une approche alternative ou complémentaire au business plan traditionnel. Développé par Alexander Osterwalder, il s’agit d’un modèle visuel qui permet de structurer les idées de manière plus dynamique et interactive. Voici comment vous pouvez utiliser le Business Model Canvas dans le contexte de votre business plan :
Vue d’Ensemble du Modèle d’Affaires :
Le Business Model Canvas se compose de neuf blocs de base qui représentent les éléments clés d’une entreprise : segments de clients, propositions de valeur, canaux, relations avec les clients, flux de revenus, ressources clés, activités clés, partenariats clés, et structure des coûts. Cette vue d’ensemble aide à comprendre rapidement comment les différentes parties de l’entreprise s’articulent.
Complémentarité avec le Business Plan :
Alors que le business plan détaille la stratégie et les prévisions de manière linéaire et documentée, le Business Model Canvas offre un aperçu graphique et synthétique du fonctionnement de l’entreprise. Utilisé en complément, il peut aider à visualiser les stratégies et les concepts abordés dans le business plan.
Flexibilité et Adaptabilité :
Le format visuel et modulaire du Business Model Canvas le rend particulièrement adapté à l’itération et à l’adaptation rapide. Cela est particulièrement utile dans des environnements d’affaires changeants où la flexibilité est clé.
Facilite la Communication et la Collaboration :
Le Business Model Canvas peut servir d’outil de communication et de collaboration au sein de l’équipe de direction, permettant à tous les membres de contribuer et de visualiser comment leurs rôles et responsabilités s’intègrent dans le modèle global de l’entreprise.
Outil pour la Validation des Idées :
Utilisé dans les phases initiales de planification ou de restructuration d’une entreprise, le Business Model Canvas est un excellent outil pour tester et valider des idées de modèle d’affaires avant de les développer plus en détail dans un business plan.
S’adresser à un Public Plus Large :
Le Business Model Canvas peut être particulièrement efficace lorsqu’il s’agit de présenter votre modèle d’affaires à des parties prenantes qui ne sont pas habituées à lire des business plans traditionnels, comme de nouveaux employés, des partenaires non commerciaux, ou même des clients.
Business plan gratuit : modèle à télécharger
Vous trouverez ci-dessous un lien pour télécharger gratuitement notre modèle de business plan
350+ Exemples Business plan rédigé gratuit
En cliquant sur le lien ce dessous, vous trouverez une liste de business plan que nous avons rédigé gratuitement, ces modèles pourront vous inspirer dans la rédaction du votre business plan et prévisionnel
Articles similaires
Partager cet article, inscrivez-vous à notre newsletter, autres articles qui pourraient vous intéresser.

Ouvrir un bar à salade : le guide pour réussir
Dans un monde où la conscience de la santé et du bien-être est en constante évolution, les consommateurs recherchent de plus en

Ouvrir un bar à pâtes : le guide pour réussir
Vous avez toujours rêvé de créer votre propre entreprise dans le domaine de la restauration ? Vous êtes passionné par la cuisine

Faire un investissement locatif (avec ou sans apport) : le guide pour réussir
L’investissement locatif représente une voie privilégiée pour bon nombre d’investisseurs désireux de bâtir un patrimoine durable tout en générant des revenus passifs.

Fabrication de bougie industrielle et artisanale : le guide pour réussir
Dans un monde où l’art de la décoration et du bien-être prend une place de plus en plus importante, les bougies jouent

Devenir pisciniste, piscinier : le guide pour réussir
Avec l’essor du marché de la construction et de l’aménagement extérieur, le métier de pisciniste ou piscinier est devenu une voie professionnelle

Devenir graphiste freelance : le guide pour réussir
Dans un monde de plus en plus connecté et digitalisé, de nombreuses professions traditionnelles évoluent vers des modèles de travail plus flexibles
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Modèle de Business Plan en PDF à télécharger

Le business plan (plan d’affaire en français) est un document officiel qui permet de présenter simplement et efficacement son projet de création/reprise d’entreprise.   
Grâce à ce business plan, votre interlocuteur doit comprendre facilement votre projet, votre produit, votre service. Il connait vos motivations, vos atouts et les objectifs que vous avez. Après avoir évalu é vos valeurs et le sérieux de votre projet, il pourra prendre position concernant votre future entreprise.
Le format du business plan
Concis, soigné, précis et bien structuré sont les mots d’ordre pour un business plan réussi . Il n’y a pas de format type mais certains points doivent être abordés dans un ordre logique :
	L’exécutive summary
	Votre présentation et celle de votre équipe
	La présentation générale du projet
	La partie économique
	La partie financière
	La partie juridique
	Les annexes

Les intérêts d’utiliser un modèle de business plan gratuit
Utiliser un modèle de business plan vous permet de n’oublier aucune de ses parties. Cela permet d’en comprendre la structure, d’identifier les informations à mettre dans chaque partie : ce n’est pas toujours évident lorsque l’on a la tête dans le guidon !
Un modèle permet de visualiser l’ensemble des infos à faire figurer. Des exemples peuvent vous aider à savoir comment aborder la rédaction de ce business plan. Enfin, cela permet de cadrer la réflexion afin d’être clair, exhaustif, compréhensible de tous et surtout bien structuré.
La structure de notre business plan en pdf à télécharger
Notre modèle contient plusieurs parties, chacune segmentée en sous-parties qui seront détaillées dans le PDF :
	Résumé opérationnel
	Présentation de l’entreprise et de l’entrepreneur
	Analyse du marché et du produit
	Produit/service
	Production et commercialisation
	Stratégie de développement et communication
	Dossier financier (n’hésitez pas à télécharger notre modèle de prévisionnel
	Clés de la réussite

Téléchargez notre modèle de Business Plan en PDF
Nos experts vous accompagnent dans l’une des étapes les plus importantes de votre création / reprise : le business plan. Grâce à notre modèle, vous pourrez compléter toutes les parties nécessaires à la présentation de votre projet aux partenaires financiers.

Créer un business plan gratuitement
Par où commencer ? N’hésitez pas à repartir d’un modèle existant pour être certain de ne rien oublier. Cela vous permet d’avoir une base structurée et de compléter les différentes parties.
Notre conseil : rédiger ce business plan sur un fichier de traitement de texte de type Word pour pouvoir le modifier plus facilement. Il vous suffira ensuite d’ajuster la mise en page et de l’exporter en format PDF pour le diffuser aux différents partenaires que vous rencontrerez.
Le business plan se doit d’être complet et doit donner envie d’être parcouru : optez pour un regard d’expert ! Nos comptables pourront vous prodiguer tous leurs conseils pour que votre projet parte sur de solides bases. 😉
Vous avez l’idée, le projet ?  Mais vous souhaitez être rassuré avant de vous lancer, être appuyé dans vos démarches et après votre installation ?
Nos dernières actualités


Coover ❯ Modèles ❯ Comment construire son Business plan ? ❯ Business plan : notre modèle gratuit
Business plan : notre modèle gratuit
La mise en place d'un business plan est un passage obligé dans la vie de tout entrepreneur. Coover vous accompagne dans cette tâche en vous proposant un modèle (excel) de business plan gratuit !
Si vous souhaitez bénéficier rapidement d'un modèle déjà pré-complété (fichier Word et Excel) pour votre projet, vous pouvez télécharger un exemple de business plan sur le site :  Créer-Mon-Business-Plan.fr .

Pourquoi faire un business plan ?
Le business plan est un document qui permet de présenter de la manière la plus efficace possible le projet de l'entreprise (au moment de la création ou après). Ce document doit permettre de vérifier la viabilité et la solidité de votre projet d'un point de vue stratégique et financier.
Tout d'abord, le business plan est un bon moyen de prendre du recul sur la structure de son projet pour identifier de manière pertinente les tenants et les aboutissants de ce dernier. Egalement, le business plan est un élément très important si vous souhaitez un jour présenter votre projet à des investisseurs . Ces derniers seront très attentifs à la rentabilité de votre projet.
Souvent, un business plan peut se présenter sous la forme de deux fichiers :
	un fichier word qui explique les étapes clés du développement de l'entreprise, ce qui donne des explications économiques et stratégiques du projet.
	un fichier excel qui retrace tous les flux financiers de l'entreprise, ce qui donne une explication financière du projet.

Dans notre modèle, nous nous sommes concentrés sur le fichier excel.
Comment fonctionne notre modèle de business plan ?
Notre modèle est donc un fichier excel. Nous avons considéré qu'il était pertinent de le construire sur la période de 2022 à 2025 avec des résultats mensuels. Si vous souhaitez visualiser votre business plan sur une période différente, notre fichier est bien sûr modifiable mais veuillez mettre les mêmes périodes dans chaque onglets (sinon certains calculs seront mal exécutés). Notre document est constitué de cinq feuilles :
	L'onglet 1 qui retrace la totalité des revenus et des charges de l'entreprise (par exemple l'assurance professionnelle )
	L'onglet 2 dans laquelle vous pourrez calculer votre trésorerie. Vous n'avez rien à remplir sur cette feuille, elle est totalement dépendantes des autres
	L'onglet salaires ou vous remplissez selon les différents postes les différentes rémunérations possibles avec des éventuelles évolutions
	L'onglet hypothèses qui sont nécessaires à la construction du business plan pour évaluer les dépenses
	L'onglet politique d'amortissement pour calculer la dotation aux amortissement (mensuelle)

Quels sont les champs de notre modèle de business plan ?
Dans ce business plan, les valeurs que vous devez rentrer se situent dans les cellules surlignées en bleu . Toutes les autres cellules sont dépendantes des bleues et s'adaptent donc en conséquence de vos choix. Il faut être attentif car parfois vous devez remplir des valeurs pour chaque mois de chaque année, parfois pour chaque année et enfin dans certains cas c'est une valeur unique pour les 3 ans. Vous devez donc remplir tous les champs suivants :
	Rythme d'ouverture, qui correspond au nombre d'ouverture de bureaux durant la période correspondante
	Chiffre d'affaire brut
	Achat de matière première stockées : cette dépense intervient seulement lors de l'ouverture d'un nouveau bureau
	Loyer, par bureau
	Entretien immobilier, par bureau
	Honoraires comptables, trimestriel
	Marketing et communication : vous remplissez le pourcentage du CA que représente cette dépense. Si, pour votre activité, cette dépense ne se calcule pas de la sorte, vous pouvez entrer d'autres valeurs à la mains pour chaque mois
	Frais bancaires
	Frais de personnel intérimaire (lorsque le personnel est mis à disposition par une entreprise de travail temporaire)
	Charges patronales (entre 25 et 42% du salaire brut)
	Les salaires. Vous pouvez modifier les noms "poste 1", "poste 2"... Si vous voulez modifier les dates, veuillez à bien les écrire de la plus proche à la plus lointaine (en première ligne AC3 la plus proche, ensuite la deuxième plus proche...). Enfin, vous avez aussi la possibilité de préciser d'éventuelles augmentations. Parfois il y a "n/a" car si le poste a été créé en 2023 par exemple, il ne peut pas y avoir d'augmentation en année 2 (donc 2025 par rapport à 2023) car le business plan s'arrête en 2024.
	Voyages & déplacements
	Vie au bureau, de manière générale et pas pour chaque bureau, sinon ça va dans la catégorie "entretien immobilier"
	Achat fournitures de bureau, ces dépenses sont activées dès qu'un nouveau salarié arrive (donc dépendent des dates d'arrivées remplies dans la feuille "salaires")
	Prix des machines ainsi que la durée d'amortissement
	Prix des aménagements, travaux, permis ainsi que la durée d'amortissement
	Prix des équipements informatiques ainsi que la durée d'amortissement
	Prix du mobilier ainsi que la durée d'amortissement

Ces quatre dernières dépenses entrent dans la catégorie des immobilisations corporelles, il faut donc les amortir. Nous vous avons donné des indications pour les durées d'amortissement.
Même si nous avons essayé de construire un modèle complet, sachez tout de même qu' un business plan dépend vraiment de chaque entreprise et que vous serez donc sûrement amenés à rajouter des dépenses qui vous sont propres.
Si vous voulez rajouter des informations, vous devrez modifier les formules (ajouter une ligne de plus à une somme par exemple) pour que vos valeurs restent vraies.
Quelles sont les valeurs clés du business plan ?
Un des objectifs du business plan est de calculer des valeurs clés qui sont censées être représentatives de la santé de votre entreprise . Si vous présentez votre business plan à des investisseurs, ces derniers seront particulièrement attentifs à ces indications. Certaines de ces valeurs clés sont surlignées en vert (si elles sont positives) ou en rouge (si elles sont négatives). Voici les agrégats intéressants calculés par notre modèle :
	L'EBITDA (earnings before interests, taxes, depreciation and amortization) et EBITDA margin (égale à EBITDA / CA). L'EBITDA est un indicateur qui se rapproche de l'EBE (excédent brut d'exploitation), à la seule différence que l'EBE ne prend pas en compte les dotations aux provisions d'exploitation.
	EBIT (earning before interests and taxes) ou REX (résultat d'exploitation), qui traduit la marge réalisée par l'entreprise sur son activité industrielle et commerciale et EBIT margin (égale à EBIT / CA)
	Trésorerie de fin de mois et cumul de trésorerie

Sur le même thème :
	Business plan bar : notre modèle gratuit
	Business plan salon de coiffure : notre modèle gratuit
	Business plan boulangerie : notre modèle gratuit
	Business plan immobilier : notre modèle gratuit
	Business plan food truck : notre modèle gratuit
	Business plan tourisme : notre modèle gratuit
	Business plan e-commerce : notre modèle gratuit

Avez-vous aimé cet article ?
7 commentaires à "business plan : notre modèle gratuit", andré, le 17 septembre 2022.
Bonsoir j'ai besoin d'un modèle de plan d'affaires
Pierre Fruchard, le 21 septembre 2022
Voici le lien suivant : https://www.coover.fr/modeles/business-plan
darrel, le 14 mars 2023
Pierre fruchard, le 15 mars 2023.
Notre modèle de Business Plan est disponible sur cette article, vous pouvez le consulter en cliquant sur le lien suivant https://www.coover.fr/modeles/business-plan/general
Cordialement
Manu, le 7 avril 2023
J'aurais besoin d'un business plan Artiste-auteur (vente œuvres originales, reproductions, droits d'auteur, cours /ateliers...) Avez-vous un modèle type ou quelque chose qui s'en rapproche ?
Merci pour vous outils et votre site, je partage :)
Pierre Fruchard, le 7 avril 2023
Nous ne disposons pas d'un business plan Artiste-auteur. Mais,il est possible de télécharger notre modèle et l'adapter à vos besoins.
Cordialement.
LOTTI, le 29 janvier 2024
merci pour tous les outils que vous mettez à notre disposition. c'est vraiment généreux de votre part.
Posez votre question Un expert vous répondra
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Simple Business Plan Templates
Plans, strategies, roadmaps – Businesses rely on these things to gain perspective on what’s about to happen. Milestones laid down in strategic and careful planning for growth and expansion, visions of where the company’s headed 10 years from now, goals that should meet timelines, all these require a smart, prudent and calculated planning.
Whether you’re a startup, an SMB, or close to a Fortune 500, a solid business plan is crucial. And of course, writing business plans is a huge task. But, what if you needed something that requires input from others though? Say, an online form or a PDF template where responses from your colleagues and managers matter? Well, here’s a collection of PDF templates for business planning.
These are beautifully designed templates, specifically tailored for businesses and companies who don’t know where to start. The hard part was already done and that’s designing the template. These will serve as boilerplates for whatever milestone your business needs. You won’t need to worry on building something from scratch, you just need to focus on the content. Some of these templates will contain or collect executive summaries, opportunities, expectations, execution, financial plans, forecasts, the whole nine yards.
Business plan templates help give a clear vision of what lies ahead. They help you get things organized, planned out, and help you check off items from your to-do list more efficiently.

Strategic Plan Template
Focus on the future and keep your company moving forward with Jotform’s Strategic Plan Template. Simply fill in the attached form with your company overview, delve deeper with a SWOT analysis, and finish off by determining your strategic goals, actions, and financial plans. Our fully-customizable template converts submitted information into polished PDFs, which you can download, print, or share instantly.

Single Page Business Plan
Get down to business with a customizable Single-Page Business Plan template from Jotform. Customize your plan in minutes. No coding. Drag and drop to build.

Operational Plan Template
This Operational Plan Sample is structured with important details for your organization. It comes ready to print, but you can simply edit the fields by putting your own organization information.

Marketing Brief Template
Managing a marketing campaign or promotion is a challenging task. You need to have a marketing plan in order to execute the campaign smoothly with the time and budget provided. Creating a Marketing Brief is very beneficial because it summarizes the marketing strategy for a specific campaign.If you are in the advertising agency or part of the marketing department, then this Marketing Creative Brief Template is for you. This well-designed template contains the client information, project information, and the marketing materials that will be used. The project details explain the project title, description, objectives, target audience, budget overview, advertising guidelines, and competitors.

Glamping Business Plan Template
Grab the attention of the investors by using this Glamping Business Plan Template. This business plan is simple yet effective because it contains all the necessary details when building a successful business.

Lean Business Model Canvas Template
See your business from a new perspective with Jotform’s Lean Business Model Canvas Template. Simply fill in a short form with problems your business could solve, how they are currently being solved in the market, and how your company can uniquely work to solve these problems. Our template instantly converts the information into polished PDFs you can download or print for your next big meeting.Our Lean Business Model Canvas Template already looks professional, but you can personalize it further to match your business. Jotform PDF Editor lets you rearrange form fields or add your company logo at the touch of a button! By instantly converting your business model into an accessible PDF format, our Lean Business Model Canvas Template can help you see the bigger picture and determine how to take your business to the next level.

SOP Template
Create a process to organize your employees in managing specific cases or scenarios by using this SOP Template. This template is commonly used in any organization whether it is a small, medium, or large group.

Creative Brief Template
A Creative Brief is used in advertising, branding, and marketing industries. In order to have a strong and outstanding creative campaign, you need to have a game plan to follow. This serves as a guideline that will help in making decisions related to the campaign.This Creative Brief Template PDF discusses the project details like the project name, due date, and project description. The marketing materials that will be used are listed in the document which includes its specifications like the dimension size, the medium that will be used, and the quantity. This is the best Creative Brief Template you can use for your next creative marketing campaign.

Business Model Canvas Template
Our Business Model Canvas Template includes nine segments which are key partners, key activities, value proposition, customer relations, customer segments, key resources, channels, cost structure, and pricing model.

Blog Post Outline Template
Use this Blog Post Outline Template for your blog content in order to get more visitors, followers, shares, and impressions. This template will definitely help your ranking in search engines.

Gym Business Plan Template
Be successful in the gym business that you're building by securing funding or a loan with the help of this Gym Business Plan Template. This PDF can be printed and given to investors or loan applications.

Meeting Minutes Template
Set goals, plan your actions, and update your team members by tracking the team meetings by using this Meeting Minutes Template. This PDF template will surely help the team in terms of planning and productivity.

Memorandum of Understanding Template
Build a harmonious relationship between two or more parties by using this Memorandum of Understanding Template. This template is easy to use and can be customized via the PDF Editor.

Pressure Washing Estimate Template
Create estimates for pressure washing services with the use of web tools. Use this Pressure Washing Estimate PDF template and create instant estimates in PDF format without the trouble of hiring programmers.

Business Hours Template
Announce and let the customers know if your business is open and not by using this Business Hours Template. This PDF template can be customized and personalized by using the PDF Editor.

Scope of Work Template
Establish the responsibilities of the service provider by using this Scope of Work Template. This document will show the list of work and tasks that should be performed by the service provider.

Custom Sales Funnel Plan

Curriculum Vitae
Curriculum Vitae Template will provide you with all the necessary information that you need for your recruitment procedure and automate the job application process of your business.

Preliminary Notice Template
Notify the parties involved like the property owner, hiring party, notifying party, and contractor about the construction project by using this Preliminary Notice Template. This PDF template can be customized if needed via the PDF Editor.

Credit Analysis

Retainer Agreement
Create retainer agreements online. Free, easy-to-customize template. Fill out on any device. Collect e-signatures. Save time with automation tools.

Business Plan Financial Template
Create a business plan financial template with Jotform Sign. Drag and drop to customize. Fill out and e-sign from any smartphone, tablet, or desktop.

Transaction Summary

Code of Conduct Template
Create a professional code of conduct to send to your employees. Can be signed from any smartphone, tablet, or computer. Easy to customize and share. No coding.
What are the seven parts of a business plan?
	Executive summary. This is an overview of your business plan. The executive summary should include your company’s offerings, mission, goals, and projections. Think of it as the elevator pitch for your business plan. If you can’t get investors interested here, it’s unlikely they’ll want to keep reading.
	Company description and history. Describe your business’s legal structure and history in addition to what you do. If you just started this business, you may replace company history with your leadership team’s experience. The purpose of this section is to explain the company structure and build confidence in the people running the company.
	Products and services. Talk about what your company offers, whether that’s products, services, or a combination of the two. Describe your products and services in detail. Explain what makes your offering unique, what your profit margins are, what kind of demand you’re seeing for it, etc.
	Market and competitor research. Investors want to know if there’s demand for your offering. Describe the target market and how your product or service benefits potential customers. Include projections of where the industry is headed over the next few years. Additionally, detail your competitors and how saturated the market is.
	Sales and marketing strategy. This part of the business plan explains how you’ll promote your product. Outline elements such as your ideal customer profile (ICP) as well as your marketing channels, budget, and methods.
	Operations and logistics. Explain how you’ll source materials if you sell products as well as the technology you need to deliver such products and services. Also, provide details about your team, like how many people you’ll need and how you’ll manage employees.
	Financial plan and projections. It’s crucial to prove that your business will be financially viable. For this, you’ll need revenue and expense projections. Many investors want to see sample account statements, balance sheets, and cash flow projections.

How do you write a business plan?
Your business plan should be a realistic roadmap that helps you build a successful company. When writing it, take a balanced approach so that you’re not blind to the potential pitfalls and risks. You’ll draft each of the seven sections previously discussed.
Tackling these sections can be overwhelming, so some people like to start with a one-page business plan that includes short paragraphs for each element. Another way to give yourself a head start is by working from a business plan template. Once you have a good start, you can expand each section to make a compelling case for your business.
Can I write a business plan myself?
Yes, you can. However, depending on your writing experience and goals, you may want outside help. If the business plan is for internal use with the purpose of improving business functions, you’ll likely be OK tackling it alone. But if you’re trying to secure funding from a bank or investors, a professional business plan writer can give you a leg up.
Even if you decide to do it yourself, have a trusted friend or business mentor review your plan and provide feedback. An objective point of view will help you refine your work.
What are the four types of business plans?
	One-page or mini business plan. The one-page option is a great way to improve the focus of your business plan and highlight the essential elements. It can be an effective way to workshop your company’s plan or quickly give others a rundown of your entire business.
	Traditional business plan. The traditional business plan is more in-depth than its one-page counterpart and will be more thorough in each section (often, plans exceed 40 pages). For example, it may contain detailed financials, branding samples, and competitive research documents.
	Business model canvas (BMC). The business model canvas is a more visual representation of your business architecture. It includes sections for infrastructure, offering, customers, finances, etc. Many businesses find the BMC appealing since it can be summarized in a single page.
	Strategic business plan. The strategic business plan can have different purposes, like proving feasibility, discussing planning operations, or projecting growth. It will outline the company’s goals, its strategy for reaching them, and the company structure. The main difference between this and the traditional plan is its focus on specific strategic initiatives.

What are the common mistakes in business plans?
	Poor writing. Sloppy writing may suggest that you’re not serious about your business or you lack the needed professionalism.
	Unrealistic expectations. While you should be optimistic about your business, if your financial projections reflect your hopes more than reality, people may hesitate to back your business.
	Lack of supporting documentation. People reviewing your business plan want to see how you back up your claims. You can include research docs, sample financials, and estimates to make your case.
	Failing to define the target audience. For a successful marketing plan, you need to define your target audience. Investors and financial institutions need to see if you’re confident about who you’re selling to.
	Unbalanced. It’s important to lay out the risks and potential upsides. This analysis shows investors that you’re considering the whole picture regarding your business.

These templates are suggested forms only. If you're using a form as a contract, or to gather personal (or personal health) info, or for some other purpose with legal implications, we recommend that you do your homework to ensure you are complying with applicable laws and that you consult an attorney before relying on any particular form.
Your account is currently limited to {formLimit} forms.
Go to My Forms and delete an existing form or upgrade your account to increase your form limit.
Business Plan Templates
Free Download

2 Essential Templates For Starting Your Business. Available as an interactive PDF or a Google Docs template.
With this business plan template, you'll be able to:
	Write a company description that sells your story
	Plan for the future: lay out goals and metrics for success
	Describe your product line in detail and plan for how to stand out from competitors
	Consider any legal formalities that require attention when starting your business
	Put together necessary financial projections to make a strong start
	Create your buyer persona and determine your product/marketing fit


Build A Business Plan That Works
Available as a one-page interactive PDF and a full template on both Google Docs and Microsoft Word!
Whether you’re starting a business or drafting a formalized document with  your current business goals, it’s important to clearly defi ne the scope of all aspects of the venture — from mission, to target customers, to fi nances, and beyond.
When just starting out, it can be tempting to think of a business plan as simply your company’s name and a description of your product or service. But in reality, planning a business involves thinking through a lot more details.
In this business plan template we’ll guide you through the steps of writing company and product descriptions, setting sales and marketing goals and plans, and thinking through legal and fi nancial logistics. We've included a  plain text, designed , and  completed example version of this template. 
Frequently Asked Questions (FAQs)
How do you write a business plan.
A business plan is a formal written document that you can use to identify the purpose of your company, make important decisions about your future and help grow your company. HubSpot's free business plan templates provides guidance to establishing your company mission, customer research, competition, and a business strategy to profitability.
Why do I need to fill out the information requested?
We will always keep your personal information safe..
We ask for your information in exchange for a valuable resource in order to (a) improve your browsing experience by personalizing the HubSpot site to your needs; (b) send information to you that we think may be of interest to you by email or other means; (c) send you marketing communications that we think may be of value to you. You can read more about our privacy policy here .
Where can I get a free business plan template?
HubSpot's Free Business Plan Templates are the best way to create a professional, thorough business plan. The templates include instructions and everything you need to know about starting your company.
Is this really free?
Absolutely.
Just sharing some free knowledge that we hope you’ll find useful. Keep us in mind next time you have marketing questions!
What are the basic format of a business plan?
A business plan is a written document that outlines the company's goals, strategy and implementation. The format of the plan varies depending on the type of organization (e.g., for-profit or nonprofit) and size, but most plans share some common features such as an overview, executive summary, and financial information.
What is the best business plan template?
A great business plan template clearly defines the scope of the venture -- from mission, to target customers, to finances, and beyond. HubSpot's business plan template will guide you through the steps of writing company and product descriptions, setting sales and marketing goals and plans, and thinking through legal and financial logistics.
What is needed to start a business?
If you're thinking about starting a business, you'll need to do some research first. You can't just start a business without doing any market research. Market research will tell you if there's an opportunity to turn your idea into a successful business. After that, write your business plan so that you know how much money and time it will take for the project to succeed. Use HubSpot's free business plan template today!
Set yourself up for success with this business plan template
Download the free business plan template.
All fields are required.
Easily create great, effective landing pages for free

Un Exemple Gratuit de Business Plan
Vous êtes perdu(e) et vous ne savez pas comment réussir votre business plan ? Pas d'inquiétudes !
Nos modèles ont aidé plus de 16 000 entrepreneurs avant vous 
Lorsque vous achetez un modèle, notre équipe d'experts vous accompagne et répond à toutes vos questions.

Cet exemple de business plan vous permet de comprendre ce que contiennent nos modèles de business plans . Nos modèles sont téléchargés tous les jours par des entrepreneurs qui souhaitent développer leur entreprise. Vous avez une question sur un modèle ? Vous avez besoin d'accompagnement ? N'hésitez pas à nous contacter . Également, sachez que nous pouvons réaliser votre business plan sur-mesure, de A à Z .

Le business plan se structure en 5 parties, qui s'enchaînent naturellement, afin de faciliter la lecture. Ceci est la structure pour un business plan de crêperie. Pour d’autres types de projets, nous changeons la structure du business plan pour s’adapter au secteur, à l’industrie et au marché.

La première partie du modèle de business plan donne le contexte du projet et une vue d’ensemble sur le marché. Cette partie prouve (au lecteur du business plan) que vous avez fait des recherches sur votre marché, que vous avez conscience des dynamiques en cours et des facteurs qui font qu’un projet comme le vôtre peut devenir rentable.

Cette partie montre que vous connaissez votre marché, sa taille, sa valeur et ses dynamiques. Nous avons déjà synthétisé les chiffres les plus récents de chaque marché et chaque industrie. Nous mettons ces chiffres à jour plusieurs fois par an. Comme partout dans le modèle, le texte est modifiable.

Trouvez le modèle qui vous convient

Tous nos modèles comprennent une présentation synthétique des tendances récentes et futures de l'industrie. L'analyse de ces tendances montre que vous êtes au courant des changements dans les habitudes de consommation et que vous allez développer un projet qui s'adapte aux besoins et aux envies de votre marché. 

Cette partie du business plan prouve que vous avez conscience des facteurs qui vous permettront de construire une entreprise pérenne et rentable.

Après le contexte, voici la présentation de votre projet.

Ici, vous présentez votre projet comme si vous vous adressiez à votre marché cible. Ainsi, vous mettez en valeur certains points forts de votre future entreprise. Dans tous nos modèles, nous faisons volontairement des présentations très “classiques” pour que vous puissiez reprendre le maximum d'éléments.  Vous pouvez modifier le texte et changer les photos.

Ici, vous présentez quelques points forts de votre projet, avec des illustrations.

Dans tous nos modèles, nous illustrons cette partie avec des photos et des textes, que vous pouvez facilement modifier, si vous le souhaitez.

Ici, vous présentez votre proposition de valeur en 3 points. La proposition de valeur représente la valeur que vous apportez à votre marché, elle doit faire partie du business plan.  Vous pouvez bien entendu modifier le texte.

Ici, vous présentez le porteur de projet. Il faut décrire brièvement son parcours professionnel et démontrer qu’il possède les qualités nécessaires pour mener ce projet à bien.  Bien entendu, la photo est modifiable.

Dans tous nos modèles, nous avons une partie dédiée à l’étude de marché. Nous évoquons les segments de marché possibles pour votre activité, la SWOT, une étude de la concurrence et une présentation des avantages concurrentiels. 

Il est fort probable pour qu'on rencontre différents profils, similaires, sur votre marché. Ces sous-ensembles sont appelés des segments de marché . Vous aurez probablement des segments de marché proches de ceux du modèle. Si ce n'est pas le cas, vous pouvez bien entendu modifier le texte.

La matrice SWOT est la structure privilégiée pour présenter son environnement concurrentiel dans un business plan. Tous nos modèles contiennent des analyses SWOT déjà rédigées en fonction du secteur. Vous pouvez, bien entendu, modifier les points forts, les points faibles, les opportunités et les menaces.

Cette étude de la concurrence permet de présenter les informations sur vos concurrents de façon structurée et schématisée, tout en mettant en avant leurs points faibles. Dans tous nos modèles, vouspouvez changer le nom desconcurrents mais également modifierles critères sur lesquelles voussouhaitez les comparer.

Ce mapping concurrentiel permet de comprendre rapidement comment vous vous démarquez de la concurrence. Vous pouvez facilement changer facilement les titres des axes et le nom des concurrents. Également, vous pouvez changer l'emplacement des boxes.

Cette partie sert à montrer votre stratégie, en 4 points, pour vous démarquer de la concurrence et gagner des parts de marché. Ce sont vos avantages concurrentiels .  Nous avons rédigé 4 avantages, en fonction du secteur en question. Vous pouvez facilement changer les noms des avantages concurrentiels ainsi que les icônes. 

Dans tous nos modèles, vous retrouverez cette partie essentielle, qui permet d’expliquer comment vous allez implémenter votre stratégie pour être rentable.  Nous avons adapté les éléments stratégiques en fonction du secteur en question. Vous pourrez également vous appuyer sur ces éléments pour trouver des clients et augmenter votre chiffre d'affaires.

Dans tous nos modèles, vous retrouverez un plan d’action sur 3 ans, construit par nos experts et adapté au secteur en question.  Vous pouvez choisir d'implémenter ce plan pour votre entreprise. Également, cette partie du business plan montre que vous êtes organisé et que vous avez une vision long terme pour votre projet d'entreprise.

Dans tous nos modèles, vous retrouverez un business model canvas déjà rédigé, en fonction du secteur. Le Business Model Canvas est un outil clé qui synthétise les informations de votre business plan. 

Dans tous nos modèles, vous retrouverez une stratégie marketing détaillée, adaptée en fonction du secteur. La stratégie marketing est essentielle dans un business plan : elle montre que vous avez un plan commercial en place pour acquérir de la clientèle et augmenter votre chiffre d’affaires.

Le plan d’acquisition marketing permet de montrer comment vous allez implémenter votre stratégie marketing

Cette partie permet de montrer que vous êtes proactif, que vous avez déjà envisagé les risques potentiels et même déjà réfléchi à une solution pour mitiger l’impact de ces risques.

Cette dernière partie (avant les conclusions du prévisionnel financier) permet de synthétiser de façon convaincante les raisons pour lesquelles votre projet est viable … et mérite un financement. Si besoin, vous pouvez facilement modifier les arguments évoqués.

Enfin la partie financière permet au lecteur du business plan d'apprécier la future rentabilité et la solidité financière de votre projet d'entreprise. Vous pouvez utiliser nos prévisionnels financiers pour construire facilement vos tableaux. Ces modèles sont simples d’utilisation, complets et conviennent pour une demande de financement auprès de partenaires financiers.

Le compte de résultat prévisionnel permet de voir si une entreprise va enregistrer un bénéfice ou une perte pendant les années à venir. Les lignes du tableau se calculent automatiquement quand vous modifiez les hypothèses du prévisionnel financier. Nous pouvons relire et corriger gratuitement votre compte de résultat si vous nous l'envoyez. 

Le bilan prévisionnel permet d’analyser la future situation financière d'une société. Les lignes du tableau se calculent automatiquement quand vous modifiez les hypothèses du prévisionnel financier. Nous pouvons relire et corriger gratuitement votre bilan prévisionnel si vous nous l'envoyez. 

Le budget de trésorerie prévisionnel permet de présenter les dépenses et les recettes prévues, sous forme de flux monétaires prévisionnels. Les lignes du tableau se calculent automatiquement quand vous modifiez les hypothèses du prévisionnel financier. Nous pouvons relire et corriger gratuitement votre budget de trésorerie si vous nous l'envoyez. 

Les soldes intermédiaires de gestion permettent d’analyser en détail la performance financière d’une entreprise. Ils se calculeront automatiquement quand vous compléterez les hypothèses du prévisionnel financier.  Nous pouvons aussi les relire gratuitement.

Le besoin en fonds de roulement présente les fonds dont l'entreprise a besoin pour financer son cycle d’exploitation. Ces indicateurs se calculeront automatiquement quand vous compléterez les hypothèses du prévisionnel financier.  Nous pouvons aussi les relire gratuitement.

Le plan de financement permet de s’assurer de l’équilibre financier d’un projet en mesurant ses besoins et ses ressources. Nous pouvons relire et corriger gratuitement votre plan de financement si vous nous l'envoyez. 

Enfin, vous bénéficiez de 3 pages d’icônes pour pouvoir modifier facilement la présentation. 
	le choix d'une sélection entraîne une actualisation complète de la page
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BUSINESS PLAN PRESENTATION GENERALE

Le marché a subi diverses crises : vache folle, baisse de la consommation de viande liée notamment au pouvoir d'achat, mais les consommateurs apprécient le travail des professionnels qui leur garantissent une viande de qualité. Le marché reprend et pour en bénéficier, je dois mettre en avant mon savoir-faire pour me démaquer de la grande distribution.
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Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.

Need more help?
Want more options.
Explore subscription benefits, browse training courses, learn how to secure your device, and more.

Microsoft 365 subscription benefits

Microsoft 365 training

Microsoft security

Accessibility center
Communities help you ask and answer questions, give feedback, and hear from experts with rich knowledge.

Ask the Microsoft Community

Microsoft Tech Community

Windows Insiders
Microsoft 365 Insiders
Was this information helpful?
Thank you for your feedback.
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COMMENTS
	[Gratuit] Un Business Plan .pdf de 35 pages (rédigé)
Dans cet article, nous vous proposons un exemple gratuit de business plan PDF. Également, nous répondons aux questions suivantes : - Qu'est-ce qu'un business plan PDF ? - Quelle est la définition d'un business plan ? - Quelles différences entre un business plan et un business model ?




	Business Plan
Téléchargez notre modèle vierge de business plan et suivez nos conseils pour bien le remplir ! 100% gratuit Rédigé par un pro Modèle à jour Vous êtes sur le point de lancer votre projet et cherchez comment faire un business plan ?




	Free PDF Business Plan Templates
Strategic planning Free PDF Business Plan Templates and Samples Get free Smartsheet templates By Joe Weller | September 9, 2020 We've gathered the most useful collection of business plan PDF templates and samples, including options for organizations of any size and type.




	Business plan PDF [téléchargez le vôtre parmi + 50 modèles]
1 Répondez à nos questions pour compléter le modèle 2 On s'occupe des calculs compliqués 3 Téléchargez votre business plan au format PDF Réalisez votre business plan en PDF sur mesure Si vous n'avez pas l'habitude de rédiger des business plans, ce modèle de business plan est la solution idéale pour vous guider dans cet exercice périlleux.




	Business plan en PDF : modèle, exemple et solutions pour l'établir
Modèle de business plan en PDF. Le modèle en PDF que nous vous proposons vous permet d'obtenir une structure de business plan. En pratique, il sera compliqué de le réutiliser en l'état pour élaborer votre business plan sur-mesure. Pour cela, nous vous recommandons d'utiliser notre application ( voir ici ). Vous pouvez télécharger ...




	Modèle de business plan gratuit à télécharger
Modèle de business plan gratuit à télécharger Vous êtes à la recherche d'un modèle de business plan gratuit à télécharger ? Bonne nouvelle, vous êtes sur la bonne page ! Document détaillant votre projet ainsi que vos objectifs pour les 3 ou 5 ans à venir, le business plan est essentiel pour créer votre entreprise.




	Download Free Business Plan Examples
Download a free business plan in PDF or Word doc format to make writing a plan fast and easy Find Your Sample Plan Discover the sample plan that best fits your business. Search our gallery of over 550 sample business plans and find the one that's right for you. View the Gallery What You'll Get:




	Business plan simple : modèle gratuit sous Word
Ce modèle vous appartient : ajoutez de nouvelles sections ou supprimez celles qui vous sont inutiles s'il y a lieu. Personnalisez ce business plan en ajoutant votre logo et votre branding. Téléchargez-le au format Word ou PDF. Imprimez-le, envoyez-le par e-mail : faites comme vous voulez.




	Free Business Plan Template for Small Businesses (2024)
A faster way to plan. LivePlan is the #1 planning tool for over 1 million businesses. Create your business plan. Download a free business plan template in Google Doc, Microsoft Word, and PDF formats. Includes expert guidance to help fill out each section.




	Business Plan Template in PDF
Complete our business plan template in PDF to connect with investors, and find new opportunities to grow. Give profits an even bigger boost by using our multi-currency business account with bank details in 8 currencies to send and receive payments from your partners and clients abroad and at home. Download template Open a business account.




	Free Simple Business Plan Templates
Try Smartsheet for Free. In this article, we've compiled a variety of simple business plan templates, all of which are free to download in PDF, Word, and Excel formats. On this page, you'll find a one-page business plan template, a simple business plan for startups, a small-business plan template, a business plan outline, and more.




	Business plan gratuit (2024) : exemple et modèle à télécharger (Excel+PDF)
Vous créez votre entreprise et vous souhaitez rédiger un business plan, vous trouverez un modèle de business plan au format word et pdf à télécharger gratuitement et de nombreux exemples Sommaire Besoin d'aide pour faire votre business plan ou votre prévisionnel ? Faites appel à un expert pour vous accompagner dans la réalisation de votre projet.




	Business Plan Templates: 26 FREE Samples
Operations plan. Management organization. Financial plan. Conclusion & appendix. Every section involved in a business plan is designed to help startup businesses reach their target market. A business plan asks founders and entrepreneurs to detail their business strategy in a step-by-step process that makes sense from an operational perspective.




	Modèle de Business Plan à télécharger
La structure de notre business plan en pdf à télécharger. Notre modèle contient plusieurs parties, chacune segmentée en sous-parties qui seront détaillées dans le PDF : Résumé opérationnel. Présentation de l'entreprise et de l'entrepreneur. Analyse du marché et du produit. Produit/service.




	Free editable and printable business plan templates
Document by Ubara. Startup Business Plan in Cream Black and White Modern Sophisticated Style. Document by Canva Creative Studio. Green and White Modern Business Plan Cover Page. Document by Magic Power. Orange Grey Professional Business Plan Cover. Document by Ubara. Brown and White Modern Restaurant Business Plan Document. Document by Morp.




	Business plan : notre modèle gratuit (Mise à jour 2024)
Notre document est constitué de cinq feuilles : L'onglet 1 qui retrace la totalité des revenus et des charges de l'entreprise (par exemple l'assurance professionnelle) L'onglet 2 dans laquelle vous pourrez calculer votre trésorerie. Vous n'avez rien à remplir sur cette feuille, elle est totalement dépendantes des autres




	20+ Simple Business Plan Templates
Simple Business Plan Templates. Plans, strategies, roadmaps - Businesses rely on these things to gain perspective on what's about to happen. Milestones laid down in strategic and careful planning for growth and expansion, visions of where the company's headed 10 years from now, goals that should meet timelines, all these require a smart ...




	Free Business Plan Template [Updated for 2022]
With this business plan template, you'll be able to: Write a company description that sells your story. Plan for the future: lay out goals and metrics for success. Describe your product line in detail and plan for how to stand out from competitors. Consider any legal formalities that require attention when starting your business.




	PDF BUSINESS PLAN
BUSINESS PLAN TEMPLATE DISCLAIMER Any articles, templates, or information provided by Smartsheet on the website are for reference only. While we strive to keep the information up to date and correct, we make no representations or warranties of any kind, express or implied, about the completeness, accura cy, reliability,




	PDF Business Plan
Business Plan C a vis t e FA C O N P ie r r e 0 1 0 2 0 3 0 4 5 5 t e st @ g m a il. lc d e PA I M P O L Entreprise [ Entreprise ] S o m m a ir e d u b u sin e ss p la n




	PDF Construire son Business Plan
Testez sans plus attendre le logiciel EBP Business Plan Création Pratic ! Pour activer votre version d'essai valable six mois, munissez-vous de votre justificatif d'achat et contactez-nous au 01 34 94 83 02. Table des matières. À propos d'EBP Introduction.




	Un exemple gratuit de modèle de business plan
Lorsque vous achetez un modèle, notre équipe d'experts vous accompagne et répond à toutes vos questions. Cet exemple de business plan vous permet de comprendre ce que contiennent nos modèles de business plans. Nos modèles sont téléchargés tous les jours par des entrepreneurs qui souhaitent développer leur entreprise.




	BUSINESS PLAN PRESENTATION GENERALE
BUSINESS PLAN FASCICULE EXPLICATIF REALISE POUR LES SEANCES DE TRAVAUX. Hervé Cassan, Professeur de droit, et Marie-Pierre de Bailliencourt, dirigeante d'entreprises L'idée d'un « livre-compagnon » de notre Traité pratique de négociation, paru chez Larcier en 2019, s'est imposée à nous presque naturellement.




	PDF Equity Action Plan Summary: U.S. Small Business Administration
2023 Equity Action Plan Summary: U.S. Small Business Administration. New strategies to advance equity. 6. 5. Improve access to investment capital. Small businesses and startups




	PDF Equity Action Plan
dramatically lower figure. Awards through the HUBZone and 8(a) Business Development Program set asides were even lower. Alternatively, the last tier on VA's set-aside hierarchy received the second highest volume of dollars; $461 million were awarded through the general small business set-aside. These data illustrate two factors.




	Create a form in Word that users can complete or print
Show the Developer tab. If the developer tab isn't displayed in the ribbon, see Show the Developer tab.. Open a template or use a blank document. To create a form in Word that others can fill out, start with a template or document and add content controls.




	08a 5 Attachment D ABAG Resolution 2 2024 Approval BAHFA Business Plan
Association of Bay Area Governments. Bay Area Metro Center 375 Beale Street, Suite 800 San Francisco, CA 94105-2066. Phone: (415) 820-7900 Fax: (415) 660-3500 [email protected]
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